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STEP-5: Fitting Falling-Prevention Wire
¢ Pass through the falling-prevention wire to the mounting material.

—1if§ e Falling-prevention
Pass through falling-prevention wire

STEP-6: Install Telescope Mounting Material

e Pass through the falling-prevention wire to the mounting material.

Connect Caranabi of falling
prevention cable with the
GX4000 equipment

Falling-prevention wire
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¢ Fix the telescope fixing material using two (2) holes of four (2) holes of
connection material.

Fixing holes are used for two horizontal holes or two vertical holes

- e e
.

[ !
I i
J A4
I i
! [
I [
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Installation Bottom Installation Top

Installation Left or Right

Rotating hand screw tightly to fix |
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3.9.4 Instrunction of Telescope

e Look through a telescope, right eye releaf is necessary.
Right releaf is 7 to 10 cm.

: Shadow

Right eye releaf Bad eye releaf

¢ For long distance target or enlargement of target, rotate the zoom ring.
e For blurred image, rotate forcus ring

Forcus Ring E
' / Zoom Ring
——————————————
Forcus Ring (30-feet to infinite) Zoom Ring (3t0 9)
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3.9.5 Instrunction of Sighting Device

¢ Look through a telescope, right eye releaf is necessary.

Open Sight
- Look in through V-gap on mount rail

- Short distance use

Peep Sight

- Look in through round holes

- Long distance use
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Maintenance

4

4.1

4.2

Maintenance and Trouble Shooting

Overview

This chapter explains how to do the maintenance of GX4000 link. Main topics
covered are;

Routine Maintenance
Loopback Function

ODU Removal for replacement
ODU replacement

Firmware update

Housekeeping

Cleaning of optical connector

Routine Maintenance

Summary

Routine maintenance is carried out by WebLT regularly and monitoring items
are as follows;

® Summary

® Radio Performance

® Click Summary menu

® Confirm that all Categories are Normal

* Summary
» Configuration
» Alarm
* Radio
w System
« idormation
-
o NIP
= Log Server
» Ports
« Secuy

« HTTPS
« Access Management
» SNMP

» Spanning Tree
» SyncE
» MAC Table

» VLAN Transtation
» VLANS
» Monitor
» TestADiagnostics
» Maintenance

» hittp:/192.108.0.10

P-Bex|

o e
Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

&) Broaddne_GX4000

Summary Auto-refrash Rafrash

Alarm Summary 2013-02-05704:32:32400-00 |

| Category | Status

Hardware . Errac

Radio Waming

Line Warning Detail Informaton |
Clock @ Normal

Console & Normal

Test&Diagnostics Summary

Ttem Current
L >
Radio x OFF Operate
Line | Loopback
Configuration Summary
T Tx Power (aBm) 100
Disabled [
-400
]
R Alarm Threshold | 10E-04 |

Alarm Summary Menu

BroadOne GX4000 Manual (R3.0) issue 1.03
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® If Warning and/or Error is issued, click Detail Information button

® |dentify the cause from alarm and description list

= Summary

P~BoX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet

[Nakahara001#:]

v Configuration Monitor > Alarm

= Alarm
= Radio

L]

Auto-refresh [ |_Refresh

2013-02-06T07:58:45+00:00

EE—)

:ggttsem No.| Level | Time | Category | Condition Description
» Security 1 Warning 2013‘(:!2' Hardware Internal Power Source Failure
5 06T01:22:01+00:00
» Spanning Tree 2013-02-
= SyncE 2 Warning o g Radio RS Synchronization Loss
06T01:21:30+00:00
*MAC Table 5 Warning  2013-02- i MOD_NR(Module Not Ready (mirroring
» VLAN Translation aming  pgT01:21:21+00:00 ine hardware output pin))
v VLANs I 4 Warning 2013-02- Line RX_CDR Unlocked(Unlocked:Loss of Lock
= VLAN Membership 9 D6T01:21:21+00:00 of RX side CDR)
b Ot 5@ o 21302 i RX_LOS(RX Loss of Signal (mirroring
> Monitor y 06T01:21:21+00-00 hardware output pin))
» Test&Diagnostics T B 5 RX_NR(Any condition leading to invalid
» Maintenance aming pgT01:21:21+00:00 g data on the RX path)
2013-02- .
7@ Error 06T01-21-20+00-00 Hardware 10 Error
8@ Eror Shon s Hardware  Startup Failure
06T01:21:20+00-00 P
1 @ Info Sg}g}qg;,zo«»oo-oo Line Optical Power Received Out of Range
10 @ Info gg}?ﬁoga 2040000 Line Optical Power Received Degrade
Monitor > Alarm Sub Menu
No Category Cause Factor Status Description Level
1 EQPT Processor Failure E
2 EQPT Start-up Failure E
3 EQPT Internal Heath Check Failure E
4 EQPT Internal Clock Failure E
5 EQPT PLL Failure E
6 EQPT TXBlock Failure E
7 EQPT XFP Optical Module Absence E
8 EQPT XFP Optical TX Block Failure E
9 EQPT SFP Optical TX Block Failure E
10 EQPT 10G PHY Failure E
11 EQPT 1G PHY Failure E
12 Hardwar EQPT Internal Data Failure E
13| ardware EQPT IO Failure E
14 EQPT FPGA Upload NG E
15 EQPT Software Upload NG E
16 EQPT FPGA Image Select NG E
17 EQPT FPGA Config Invalid (nStatus/CONF_DONE Invalid) E
18 EQPT Internal Power Source Failure E/W/I
19 EQPT/ENVR High Temperature E/l
20 ENVR/ENVR Laser Temperature High E/l
21 ENVR Low Temperature W/I
22 ENVR Laser Temperature Low W/I
23 (MON INFO) L2SW Failure w
24 (MON INFO) FPGA Config RAM CRC Failure |
25 EXT Sync-E PLL DPLLO UNLOCK W
26 Clock EXT Sync-E PLL DPLL1 UNLOCK W
27 EXT Sync-E PLL DPLLO HOLDOVER W
28 EXT Sync-E PLL DPLL1 HOLDOVER W
4-2 BroadOne GX4000 Manual (3.0) issue 1.03
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E: Error, W: Warning, I: Information

No Category Cause Factor Status Description Level
29 EQPT Optical Power Transmitted Out of Range E
30 EXT External Clock Degrade on Sync Ethernet Line W
31 EXT External Clock Degrade on Sync Ethernet CRPI W
32 EXT External Clock Degrade on Sync Ethernet L2SW W
33 EXT XFP RX_NR (Any condition leading to invalid data on the RX path) W
34 EXT XFP RX_LOSS (mirroring hardware output pin) |
35 EXT XFP RX_CDR Unlocked (Unlocked: Loss of Lock of RX side CDR) W
36 EXT XFP MOD_NR (Module Not Ready (mirroring hardware output pin) W
37 EXT 10G PHY SIDE-MAC Transmit FIFO Underrun \W
38 EXT 10G PHY SIDE-Transmit Frame Abort W
39 EXT 10G PHY SIDE-RX Symbol Error Count W
40 EXT 10G PHY SIDE-RX Unsupported Opcode Count W
41 LINE EXT 10G PHY SIDE-RX CRC Error Count W
42 EXT 10G PHY SIDE-RX Undersize Count W
43 EXT 10G PHY SIDE-RX Undersize with CRC Error Count W
44 EXT 10G PHY SIDE-RX MAC Client Data Length Mismatch Regal Length Field W
45 EXT 10G PHY SIDE-RX Owersize Count W
46 EXT 10G PHY SIDE-RX Owersize with CRC Error Count W
47 EXT Optical Power Received Degrade W/I
48 EXT Optical Power Received Out of Range W/l
49 EXT SFP RX LOSS (RX Loss of Signal, mirroring hardware output pin) |
50 MON INFO LINE XAUI Packet Discard W
51 MON INFO LINE XAUI Packet Overflow W
52 MON INFO Optical Power Transmitted Degrade W
53 MON INFO Line Loopback Test |
54 EXT External Clock Degrade on Sync Ethernet Radio W
55 EXT Radio Overhead Parity Error W
56 EXT RF XAUI Packet Discard W
57 EXT RF XAUI FCS Error W
58 EXT RF XAUI Abnormal Length Packet Discard W
59 EXT Radio BER Alarm W
60 RADIO EXT RS Synchronization Loss W
61 EXT RF Power Received Out of Range W
62 EXT RF Route ID Fail W
63 (MON INFO) RF Power Transmitted Out of Range W
64 (MON INFO) Auto Level Control Failure W
65 (MON INFO) Auto Gain Control Failure W
66 (CONT INFO) Radio Loopback test |
67 (CONT INFO) Radio TX OFF Test |
68 EXT MII Status Auto-Negotiation Complete NG \W
69 EXT MII Status Remote Fault W
70 EXT MII Status Link Status NG W
71 EXT MII Status Jabber Detect W
72 EXT 1000BASE-T Status Master/Slave Configuration Fault W
73 EXT 1000BASE-T Status Remote Receiver Staus NG W
74 EXT 1G-PCS Synchronization Has Been Lost Wi
75 Console EXT 1G-RX Symbol Error Count w
76 EXT 1G-RX Unsupported Opcode Count W
77 EXT 1G-RX CRC Error Count W
78 EXT 1G-RX Undersize Count \W
79 EXT 1G-RX Undersize with CRC Error Count W
80 EXT 1G-RX MAC Client Data Length Mismatch Regal Length Field W
81 EXT 1G-RX Owersize Count W
82 EXT 1G-RX Owersize with CRC Error Count W
EQPT: Equipment, MON INFO: Monitoring Information, EXT: External
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Radio Performance

® Click Monitor > Radio Performance > Current
® Confirm that Tx Level and Rx Level is within specification

Monitor > Radio Performance > Current

| Time I I ]

Fujitsu BroadOne GX4000 Series -

0

2034-08- 96T 11 1355400

00 00

Tx Level (dBm) | Rx Level (dBm) | Radio Link Quality

Radio Performance > Current

Iltem

Parameter

Specification

Tx Level (dBm)

TX output power

Setting value +/- 3 dB

Rx Level (dBm)

Received Signal Level

System design value +/- 3 dB

® Click Monitor > Radio Performance > 15 Minutes
® Confirm that 15 Minutes radio performance is within specification

bzl
T P~ 80 %) @ bosdonecx00 il
Fujitsu BroadOne GX4000 Series - Ethernet G 6
[Nakahara001#:] ~f
X CMD:'Z,M,, Monitor > Radio Performance > 15 Minutes Auto-refresh 1| [ Refresh
~ Monitor
- Al o iy Block Error Block Error
» System No | Time ___(?‘_L____‘;I“J__ Errors Seconds Ratio
c Min. | Max. | Min. | Max.
» Spanning Tree
« MAC Tabie
» VLANS
» Radio Performance
» Carrent
« 15 Minstes
« 1 Day
» Test&Diagnostics
» Maintenance
Radio Performance > 15 Minutes
Parameter T
Iltem Specification

(15min interval)

Tx Level (dBm) | Min. | TX power (Min.) Setting value +/- 3 dB
Max. | TX power (Max.) Setting value +/- 3 dB
Rx Level (dBm) | Min. | RSL (Min.) System design value +/- 3 dB
Max. | RSL (Max.) System design value +/- 3 dB
Block Error 0
Error Seconds 0
Block Error Ratio 0

4-4
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4.3 Loopback Function

Two types of loopback function are available:
® Radio side loopback
® Line side loopback

Loopback Pont for Ether Interface

Loopback point of GX4000 for Ether interface is as follows;

GX4000 Ether

10G 10G L2sW FPGA TX/RX
> > - oDU
( Site B
v | L - s 4 4 o
CPRI
]
Radio Side Loopback
GX4000 Ether
10G 10G LoSW FPGA TX/IRX
ODU N - - > > -
Site A
4 < -+ -
CPRI
-

Line Side Loopback

Loopback Pont for CPRI Interface

Loopback point of GX4000 CPRI for Ether interface is as follows;

GX4000 CPRI
10G 10G L2SW FPGA TXRX
] > > = = I
ODU
_ _ Site B
] - < « . N
CPRI
B

Radio Side Loopback
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Loopback Procedure

GX4000 CPRI
10G 10G L25W FPGA TX/RX
|— > | » - —
o ol < Il ) -
CPRI

OoDU

w

Site A

Y
3
W
"

Line Side Loopback

® Click Configuration > MAC Table and set Line and Radio to Disable
® Click Save button

= Summary
v Configuration
= Alarm
= Radio
» System
= Ports
» Security
» Spanning Tree
“SYyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

L~BCeX H & BroadOne_GX4000

<l

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Configuration > MAC Table
Aging Configuration

B

Disable Automatic Aging
Aging Time 300 seconds|

MAC Table Learning

| Port Members
|Maintenance[Line|Radio
Auto ) e =)
Disable © O
Secure (3 5 )

Static MAC Table Configuration

Port Members
Delete [ VLAN ID | MAC Address [Maintenance|Line|Radio

[ Add New Static Entry |

Save || Reset

® Click Test & Diagnostics > Control

® Click Operate button of Radio LoopBack or Line LoopBack

[E=SRESE™5)

PL~BCX “ & BroadOne_GX4000 X l‘_]

* Summary

» Configuration

» Monitor

~ Test&Diagnostics
= Control
= Ping

» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet o @
[Nakahara001#:] E

Test & Diagnostics > Control | Refresh |
Item Current | [ Timer o

Radio LoopBack - |[ Operate 30sec [+]

Tx-OFF Tx-OFF | Release |

Line LoopBack - |[ Operate [l 30sec [~]
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4.4  ODU Removal for Replacement
Prior to ODU removal, following actions should be taken:
® Record the IP Address information

Save the Configuration Information to PC

TX power OFF setting

DC power supply OFF

DDU replacement

Record the IP Address Information
® Open WebLT and Click Configuration > IP
® Record IP Address, IP Mask, IP Router and VLAN ID

7

N [E=EE 5
a' 2 ‘I'L%} http://192.168.0.10 P~BOEX H & BroadOne_GX4000 X ] 0 2.0 $0%

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summa .
vConﬁgurryation Configuration > System > IP
= Alarm
« Radio Configured | Current
¥ System DHCP Client Rer
fyeuon IP Address | 192.168.0.10 192.168.0.10

« NTP IP Mask 255.255.255.0 255.255.255.0
vk IP Router | 0.0.0.0 0000
~ Security VLAN ID 1 1
~ Switch
= Users
" HTTPS Save ] Reset

= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > System > IP

BroadOne GX4000 Manual (R3.0) issue 1.03 4-7
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Save the Configuration Information to PC
® Click Maintenance > Configuration > Save
® Click Save Configuration and store to the PC folder.
® Record PC folder name: config_yyyymmdd_hhmiss.xml

a P~BCX H & BroadOne_GX4000 LJ i %f

Fujitsu BroadOne GX4000 Series - Ethernt
[Nakahara001#:]

= Summa < - -
> c°nﬁgurryati°n Maintenance > Configuration > Save

» Monitor -
» Test&Diagnostics Save Configuration

v Maintenance
= Restart Device
= Factory Defaults
» Software
» FPGA
v Configuration
= Save
= Upload
» Data

TX Power OFF Setting
® Click Test & Diagnostics > Control
@ Click Operate button of Tx-OFF item

e

Fujitsu BroadOne GX4000 Series - Ethernt
[Nakahara001#:]

£ - B ¢ X || @ Broadone_Gx4000

= Summa
> c°nﬁgurryaﬁ°n Test & Diagnostics > Control Refresh

» Monitor Item Current | Control [ Timer

v Test&Dia[gnostics Radio LoopBack - clease 30sec [v]
L Tx.OFF Tx-OFF

» Maintenance Line LoopBack - Operate Releas 30sec [v]

Test & Diagnostics > Control

Cable Disconnection from ODU
® Remove PWR, OPT and LAN connectors from ODU
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45 ODU Replacement

Prior to ODU replacement, following action should be taken in regular order:

Removal/installation of ODU from/to antenna adaptor
Cable connection

DC power supply ON

Download Configuration information to ODU

TX power ON

Confirmation of Signal Continuity

ODU replacement form to Fujitsu Wireless Systems
ODU Removal/Installation Procedure
Please refer to Chapter 2 Site Survey & Installation, Section 2.6 ODU

installation.

Cable Connection

Connect PWR and LAN cables and OPT cable is connected after signal
continuity test.

DC Power Supply ON

Remove PWR connector on ODU
Set circuit breaker switch for ODU to ON.
Confirm that DC power supply voltage on PWR connector;

Voltage between Pin-2 (-) and Pin-7 (GND) is -40.5t0 -57.0 V

® Set circuit breaker to OFF.
® Connect PWR connector and set circuit breaker to ON

Download Configuration Information
® Open WebLT in accordance with Chapter 5, Section 5.2
® Recorded IP address information as stated Section 4.4 is input.

® Click Maintenance > Configuration > Upload

® Browse recorded save file name and click upload button

@ P~BeX H @ BroadOne_GX4000 q" ]

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] &

= Summal o
,COnﬁgu?;ﬁon Maintenance > Configuration > Upload

» Monitor P ————
» Test&Diagnostics (#88.. || Upload

¥ Maintenance
= Restart Device
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TX Power ON Setting

® Click Test & Diagnostics > Control
® Click Release button of Tx-OFF item

P~BCX H & BroadOne_GX4000

L]

Fujitsu BroadOne GX4000 Series - Ethernet

[Nakahara001#:]

= Summa
> Conﬁgurryation Test & Diagnostics > Control Refresh
» Monitor Item Current | Control |  Timer
v Test&Diagnostics Radio LoopBack - [ Operate | :se | [30sec [¢]

= Controf

: Ping Tx-OFF Tx-OFF ate | |[ Release ||
» Maintenance Line LoopBack = | Operate | eleas 30sec [v]

TX Power ON

Confirmation of Signal Continuity

® Confirm that Radio Performance is normal as shown in Section 4.2

Routine Maintenance, Radio Performance

Connection of Optical Cable

ODU Replacement Form

After completion of signal continuity test, connect optical cable.

After replacement of ODU, please send ODU to Fujitsu Wireless Systems.

For quick and adequate repair work, following information is essential to be
attached to the ODU.

Serial No.

Station name and facing station name
Frequency band

Date and time alarm/abnormality detected
Date and time the ODU replaced

Detailed description of alarm/abnormality

Detailed description after ODU replacement

Table 4.5 shows an example of “Faulty Report” format.

4-10
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Table 4.5 Faulty ODU Report (Example)

FAULTY ODU REPORT

Name

Serial No.

Station Name

Facing Station

Freq. Band TX Frequency

System Configuration

BB Interface O Ether 10GbE Optional IDU O Yes
O CPRIRE O No
O CPRIREC

If you are returning an ODU, please fill the below;--

TX output level (setting) = dBm, RSL (actual) = dBm

Environmental condition: Others:

Date/time Alarm detected (mm/dd/yy. hh:mm)

Date/time ODU replaced (mm/dd/yy. hh:mm)

Details of alarm/status and other conditions before ODU replacement

Details of alarm/status and other conditions after ODU replacement

Other comments if

any

Compiled by

Date (mm/dd/yy)

Checked by

Date (mm/dd/yy)

Approved by

Date (mm/dd/yy)
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4.6 Firmware Update

Update of software firmware and FPGA data are available using on WebLT:
For details, refer to Chapter 5 WebLT.

Firmware Update
® Click Maintenance > Software > Upload

® Browse PC folder and click Upload button

/> BroadOne_GX4000 - Windows Internet Explorer

|& ﬁ:; 9| %] [ Live se ol

(€ BroadOne_GX4000

7.7 Favorites

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summa .
» cqnﬁgu?aﬂon Maintenance > Software > Upload

» Monitor . =
) Test&Diagnostics ||_Browse... Upload
v Maintenance
= Restart Device
= Factory Defaults
v Software
= Upload
= [mage Select
» FPGA
» Configuration
» Data

FPGA Update
® Click Maintenance > FPGA > Upload
® Browse PC folder and click Upload button

/> BroadOne_GX4000 - Windows Internet Explorer

@:\ Y & S— -

(€ BroadOne_GX4000

7.7 Favorites

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= §i
> czw%au?aﬁon Maintenance > FPGA > Upload

» Monitor
» Test&Diagnostics —‘[ﬁ
v Maintenagnce l |_Browse.., s
= Restart Device
= Factory Defaults
v Software
= Upload
= [mage Select
v FPGA
= Upload
= [mage Select

» Configuration
» Data
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4.7 Housekeeping

Housekeeping items of supervisory and control information can be
connected to the external equipment.

Monitor Cable (MON) Pin Assignment

Table 4.7 shows the pin assignment of MON cable.

Table 4.7 Pin Assignment of Connector (MON)

item GX4000 Side Ext Equipment Side

Signal Direction | Connector | Pin No. Label Connector

1 CLOSE ALM - 1 ™M1 M4 Crimp

2 OPEN ALM - 2 T™M2 M4 Crimp

3 COMMON - 3 TM3 | M4 Crimp

4 NC - 4 - -

5 NC - 5 - -

6 NC - 6 - -

7 EXT XRST IN 7 TM5 M4 Crimp

8 SG - 8 TM6 M4 Crimp

Supervisory (SV) Item Parameter

SV ltem Pin No. Output device Condition Status
PS ALM 1 Photo MOS relay | 60V/0.55A | Normal: Open
4 ALM:  Close
TOTAL ALM 2
5

Control Item Parameter

Detailed parameter of Control item is shown below;

CONT ltem Pin No. Output device Condition Status

CPU Reset 7 .
Photo coupler 6.5 mA Norme}l_ Open*
[+3.3V Reset: Close (*)

NOTICE: When short-circuited more than 10 seconds, CPU will be reset
after restoring the factory default.
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4.8 Cleaning of Optical Connector

Cleaning of optical connector is carried out below:

LC connector SC connector

¢ 1.25 cleaning stick
for LC connector

¢ 2.5 cleaning stick

Wary sleave

| e

for SC connector

Cleaning stick inserts to the
wary sleeve

Cleaning stick penetrates
wary sleeve several times
without rotation

When cleaning stick do not
penetrate, rotates several times
in a same direction and take
care for wary sleeve damage.

4-14
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5 Network Management Function

This chapter describes a procedure of network management function for
BroadOne GX4000 Impulse radio equipment (Network Element). Two types
of NMS functions are available, one is Web-based local terminal and the
other is SNMP agent. A user should be familiar with a PC, an operating
system, and an application software.

Table 5.1 SNMP Function

Network Management Function Description

Status & Condition, Configuration
Web-based Local terminal (WebLT) setting & Performance Monitoring by
Web Browser

SNMP Manager SNMP agent function due to MIB Il

5.1 Web-Based LT (WebLT)

Outline of Web LT

The Web LT is a local terminal that is the main human machine interface for
operation, maintenance, system setup and tune-up. The Web LT is designed
as an embedded web server using HTTP (Hyper Text Transfer Protocol)
protocol and HTML (Hyper Text Markup Language) document format on an
IP (Internet Protocol) network. An operator can manage the GX4000 NE by
accessing with ordinary web browser client software. Table 5.2 shows the
outline of Web LT major functions.

Table 5.2 Web LT Major Functions

Status & Condition Display of alarms and conditions of card and system.
. . Setting of system configurations, optional functions and NE
Configuration
parameters.
Monitor Display of equipment and L2SW monitoring.
Test & Diagnostics Display of radio performance and analogue monitoring.
Maintenance Display of History of conditions, download and upload files

System Requirements

To use the Web LT, the PC hardware and software should meet or exceed
the requirements listed in Table 2.3.

Table 5.3 System Requirements
HTTP/1.0 or later

JavaScript' " *!
Client Requirements | Cascade Style Sheet (CSS2)
Least one working Ethernet port supporting 10/100Base-T
1024x768 or 1280x768 XGA Display recommended
Recommended Browser | Microsoft Internet Explorer *%73 \Jersion 8.0 or later
Recommended OS English version OS
*1 JavaScript is a trademark of Sun Microsystems, Inc., and refers to
Sun’s Java programming language.
*2 Microsoft Internet Explorer is a trademark of Microsoft Corporation in
the United State and/or other countries.
*3 Set Zoom on View menu to 100% and Security of Internet Option on
Tools menu to “Reset all zones to default level”.
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Applicable Character

Table 5.4 Applicable Characters

ASCII Characters
Char HEX Char HEX Char HEX Char HEX Char HEX Char HEX
(space) | 20 0 30 @ 40 P 50 ) 60 p 70
! 21 1 31 A 41 Q 51 a 61 g 71
N.A () 22 2 32 B 42 R 52 b 62 r 72
# 23 3 33 C 43 S 53 c 63 S 73
$ 24 4 34 D 44 T 54 d 64 t 74
% 25 5 35 E 45 ] 55 e 65 u 75
& 26 6 36 F 46 Vv 56 f 66 % 76
N.A () 27 7 37 G 47 W 57 g 67 w 77
( 28 8 38 H 48 X 58 h 68 X 78
) 29 9 39 I 49 Y 59 i 69 y 79
* 2A N.A (3) 3A J 4A Y4 5A i 6A z 7A
+ 2B N.A (;) 3B K 4B [ 5B k 6B { 7B
N.A (,) 2C | NA() @ 3C L A4C | NA® 5C | 6C | 7C
- 2D = 3D M 4D ] 5D m 6D } 7D
2E | N.A(®) 3E N 4E N 5E n 6E ~ 7E
/ 2F ? 3F 0] 4F . 5F 0 6F | N.A(del) | 7F

5.2  Getting Started with Web LT

Connecting PC and NE

Connect your PC to a LAN port on ODU of the target NE (Network Element).
Normally, crossover cable should be used for the connection. Connection is
10Base-T and 100Base-TX Ethernet. It is recommended to use CAT5
(Category 5) UTP (Un-shielded Twisted Pair) crossover cable for the
connection. Figure 5.1 shows the connection between the PC and the NE.

g ¢ RSN
NP g
_j_ RJ-45 jack
S PC
/ \
[ \ LAN cable
\‘ \ - ,/ j’." \'.\‘\

Figure 5.1 Connection between PC and NE
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Web Browser Setting of PC

1. Open Internet Web browser, Tool Bar > Internet Option > Connections
2. Click LAN settings and all checkmarks will undo and click OK.

Local Area Network (LAN) Seitings §|

Aukomatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration,

@Qutamatically detect settings

se automatic configuration scripk

address | http:jfpac.proxy . Fujitsu, co. jpfproxy

Proxy server

Ese a proxy server for wour LAMN (These settings will not apply to
ial-up or WPH connections).

(a4 ] [ Cancel

HTTPS Setting of PC

NOTICE: When you can apply HTTPS (Hypertext Transfer Protocol over
Security Layer), minimum key length of Web Server Certificate should be
changed to 512. If not, you cannot open WebLT.

In case of Windows 7, key length setting is as follows;

Change of key length:
Execute the following command in the dos prompt screen:

Certutil —setreg chain¥minRSAPubKeyBitLength 512

Restoration of key length:
Execute the following command in the dos prompt screen.

Certutil —setreg chain¥minRSAPubKeyBitLength 1024
For details, refer to Microsoft Security Advisory URL;

http://support.microsoft.com/kb/2661254
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Starting Web LT (*1)

After making appropriate cable connection to the NE (LAN jack on ODU),
you can start Web LT:

1. Open your web browser.

2. Enter the IP address of the NE as a URL (Uniform Resource Locator)
form.

Default IP address of NE: http://192.0.2.1
https://192.0.2.1 (when HTTPS = enable)

3. “Connect to 192.168.0.10” sub menu appears as an example.

Connect to 192.168.0.10

The server 192,165.0,10 at BroadOne_&GX4000 requires a
username and passwoard,

Warning: This server is requesting that your username and
password be sent in an insecure manner {basic authentication
without & secure conneckion),

Liser name: | | 5} w |

Password: | |

[ Iremember my password

[ Ok l [ Cancel

Figure 5.2 User name and Password sub menu

4. Input User ID and Password.
Default User ID: Admin
Default Password: null

5. When the Web LT successfully accesses to the NE, Web LT Start screen
appears.

ﬁ NOTE: IP address of NE and User ID/Password will be able to change in
the Configuration Menu on WebLT after first login.
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Start Screen

The Start Screen displays the NE ID (Network Element Identification) and
menus for the NE connected to the Web LT.

d N

=B
L

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

()] @ http://192.168.0.10 O~BeX H @ BroadOne_GX4000

= Summary
» Configuration Summary Auto-refresh | | Refresh

Y Monitor Alarm Summary

» Test&Diagnostics 2013-02-06T08:21:13+00:00
» Maintenance Category | Status

Hardware @ Error

Radio Warning

Line Warning m

Clock ¢ Normal

Console @ Normal

Test&Diagnostics Summary

Item Current

Loopback -
fadio Tx OFF Operate
Line | Loopback -

Configuration Summary

Target Tx Power (dBm) 10.0
ATPC Disabled
ATPC Target Rx Power (dBm) | -40.0
Route 1D 0

BER Alarm Threshold 1.0E-04

Figure 5.3 Web LT Start Screen

This screen is the first window displayed when the NE (ODU unit) is
accessed through the Web browser. The window consists of three sections:
(1) a banner frame and (2) a menu and main frame.

Banner Frame

The banner frame displays the NEID, the system nhame assigned to the NE
as an item for the NE Physical Inventory.

J(2)| @ nttp://192.168.0.10 £ -~ B ¢ X || @ Broadone_Gx4000 e A ke

Fujitsu BroadOne GX4000 Series - Ethernet

[Nakahara001#:]

Figure 5.4a Banner Frame for Ether interface

192.168.0.10 My ECX 3 BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - CP
[Nakahara001#:)]

||

Figure 5.4b Banner Frame for CPRI interface
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Menu Frame

The menu frame displays the menu links in order to access to the menu of
current status (Summary), provisioning menu (Configuration),
condition/status/performance (Monitor), maintenance (Test & Diagnostics)
and History/Download/Upload a file (Maintenance). In some case, a sub
menu will appear in the main frame when a link of the menu item is clicked

' NOTICE: Two (2) menu frames are available, one is for GX4000 for Ether

interface and the other is for GX4000 for CPRI interface as shown in Figure

5.5.

S NOTICE: Built-in software for Ether or CPRI interface is dependent on

GX4000 equipment code. In case that interface is changed Ether to CPRI or
CPRI to Ether in future, software and FPGA firmware upload is needed on

site.

= Summary
v Configuration
= Alarm
= Radio
» System
= Ports
» Security
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANs
¥ Monitor
= Alarm
» System
» Ports
» Security

» Spanning Tree
= MAC Table

» VLANS
» Radio Performance
¥ Test&Diagnostics
= Control
= Ping
¥ Maintenance
= Resiart Device
= Factory Defaults
» Sofiware
» FPGA
» Configuration
» Data

Summary

O~ B¢ X H @ BroadOne_GX4000

Alarm Summary

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Category | Status
Hardware @ Eror
Radio Warning
Line Warning Detail Information
Clock & Normal
Console @ Normal

Test&Diagnostics Summary

Item Current

Loopback -
Hadio Tx OFF Operate
Line | Loopback -

Configuration Summary

Target Tx Power (dBm)

ATPC

ATPC Target Rx Power (dBm)

Route 1D

BER Alarm Threshold

10.0
Disabled
-40.0

0
1.0E-04

< il it g 58
(€ s

Auto-refresh [C] | Refresh

2013-02-06T08:27:32+00:00

Figure 5.5a Menu Frame for Ether interface
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a. |\=) http://192.168.0.10

P~raACX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - CPRI |
[Nakahara001#:]

= Summary -
~ Configuration Summary Auto-refresh [C] | Refresh
= Alarm

= Radio Alarm Summary 2013-02-08T12:45:20+00-00
b System Category | Status
» Security
« Sync Hardware @ Error
¥ Monitor Radio Warning
= Alarm . [.—
S s Line @ Info Detail Information
» Radio Performance Clock @ Normal
v Test&Diagnostics Console @ Normal
= Control
= Ping Test&Diagnostics Summary
¥ Maintenance
= Restart Device Item Current
L Factofy Defaulis Loopback 2
» Software fedin Tx OFF Operate
b FPGA h Line | Loopback -
» Configuration
» Data Configuration Summary
Target Tx Power (dBm) 10.0
ATPC Enabled
ATPC Target Rx Power (dBm) | -40.0
Route ID 0
BER Alarm Threshold 1.0E-04

Figure 5.5b Menu Frame for CPRI interface

If you select a certain menu link, the menu appears in the main frame or
subwindow. When you want to transfer to the next menu, you may select the
new menu link in the menu frame.

Section 5.3 and 5.4 show the menu tree and menu description.

Help Icon

You can click Help button to know well about WebLT menu. f»

Exiting Web LT

You can exit the Web LT by clicking Logout icon or X. This terminates the
session between your PC and the NE.

)| @ http://192.168.0.10 P~BEX H @ BroadOne_GX4000 . L l

Fujitsu BroadOne GX4000 Series - Ethernet

o]

[Nakahara001#:]

Figure 5.6 Exiting WebLT
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5.3

Menu Tree & Menu Description for Ether Interface

Menu tree and menu description are shown in Figure 5.7 and Table 5-5.

Summary |

—{  Configuration | Alarm | Information |
Radio | P |
System NTP |
Ports | Log Server |

Security — Switch Users |

Spanning Tree 1 Bridge Setting | HTTPS |

SyncE | CIST Ports | Access Management |

MAC Table |
VLAN Translation  |——] Ports to Group Mapping |
- VID Translation Mapping |
T T R T

— Monitor — Alarm | Ports |
System 1 Information |
— Log |
Ports F——  Trafiic overview |
Security | “H  Detailed Statistics |

Access Management Statistics

Switch

RMON

|

Statistics |

Spanning Tree

Bridge Status

History |

T

_|

e e s O O A AR R R R A

_|
MAC Table — Port Status |
— Port Statistics |
VLANS F—  viANMembership |
— VLAN Port |
Radio Performance  |—— Current |
—{ Test& Diagnostics |— Control | H 15 Minutes |
Ping | 1 Day |
Maintenance | Restart Devices |
Factory Default |
Software e Upload |
— Image Select |
FPGA 1 Upload |
| Image Select |
Configuration | Save |
] Upload |
Data ——  csvbownoad |

Figure 5.7 Menu Tree
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Table 5.5 Menu Description for Ether Interface

Menu Description
Summary summary of current alarms
Configuration Provisioning setting
Alarm Optical pass through/Link shutdown: Enable/Disable
Radio TX power/ATPC/ATPC RX threshold/Route ID/BER threshold
System
Information System information setting
IP IP address setting
NTP NTP configuration, RTC manual setting
Log Server Server mode/Server address/Syslog level
Ports Current port configuration
Security
Switch
Users User name/User password/Privilege level
HTTPS Mode/Automatic Redirect: Enable/Disable
Access Management Mode: Enable/Disable, Add new entry
SNMP
System SNMP mode/Version/Community, SNMP trap configuration
RMON
History configure RMON History table

Spanning Tree

Bridge Setting

configure STP system settings

CIST Ports user to inspect the current STP CIST port configurations
SyncE SyncE configuration setting
MAC Table MAC table configuration setting

VLAN Translation

Ports to Group Mapping

Configuration setting of “Port to Group Mapping”

VID Translation Mapping

Configuration setting of “VID Translation Mapping”

VLANs
VLANs Membership Configuration setting of VLANs membership
Ports Configuration setting of VLAN ports

Monitor

Alarm Alarm monitoring item and item description

System
Information Current information of system/hardware/time/SW/FPGA
Log Current information of system log
Ports Current information of traffic packet

Traffic Overview

overview of general traffic statistics for all switch ports

Detailed Statistics Ratio

detailed traffic statistics for a specific switch port.

Security

Access Management
Statistics

Overview of access management statistics

Switch

RMON

Statistics

overview of RMON Statistics entries

History

Overview of RMON History entries

Spanning Tree

Bridge Status

detailed information on a single STP bridge instance

Port Status

STP CIST port status for physical ports of the switch.

Port Statistics

STP port statistics counters of bridge ports in the switch

MAC Table Entries in the MAC Table
VLANSs
VLAN Membership Overview of membership status of VLAN users.
VLAN Port Overview of VLAN port
Radio Performance
Current Current information of Time/Tx level/Rx level
15 Minutes Historical radio performance data for 15 minutes interval
1 Day Historical radio performance data for 1 day interval
Test & Diagnostics
Control Control of test and diagnosis
Ping ICMP PING packets to troubleshoot IP connectivity issues.
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Table 5.5 Menu Description (Cont’d)

Menu Description
Maintenance

Restart Devices Restart Devices, Yes/No
Factory Default Factory Default, Yes/No
Software

Upload Firmware Update

Image Select Software Image Selection
FPGA

Upload FPGA upload

Image Select FPGA image selection
Configuration

Save Configuration Save

Upload Configuration Upload
Data

CSV Download CSV download

5.4 Menu Tree & Menu Description for CPRI Interface

Menu tree and menu description are shown in Figure 5.8 and Table 5-6.

L summay |
—{  Configuration  |—— Alarm | Information |
— Radio | P |
— System NTP |
— Ports | Log Server |
— Security — Switch Users |
_| Sync | }_[: SNMP |
— Monitor 1 Alarm | l_( SYSTEM
— System 1 information |
TR
L RadioPerformance | Current |
—{ Test & Diagnostics |—— Control | 15 Minutes |
O T T O e v R
L  Maintenance | — Restart Devices |
— Factory Default |
— Software ] Upload |
— image Select |
— FPGA —— Upload |
— image Select |
— Configuration —— Save |
— Upload |
— Data ——  csvDownoad |

Figure 5.8 Menu Tree
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Table 5.6 Menu Description for CPRI Interface

Menu Description
Summary summary of current alarms
Configuration Provisioning setting
Alarm Optical pass through/Link shutdown: Enable/Disable
Radio TX power/ATPC/ATPC RX threshold/Route ID/BER threshold
System
Information System information setting
IP IP address setting
NTP NTP configuration, RTC manual setting
Log Service Server mode/Server address/Syslog level
Ports Current port configuration
Security
Switch
Users User name/User password/Privilege level
SNMP
System SNMP mode/Version/Community, SNMP trap configuration
Sync Synchronization configuration setting
Monitor
Alarm Alarm monitoring item and item description
System
Information Current information of system/hardware/time/SW/FPGA
Log Current information of system log
Radio Performance
Current Current information of Time/Tx level/Rx level
15 Minutes Historical radio performance data for 15 minutes interval
1 Day Historical radio performance data for 1 day interval
Test & Diagnostics
Control Control of test and diagnosis
Ping ICMP PING packets to troubleshoot IP connectivity issues.

Maintenance

Restart Devices

Restart Devices, Yes/No

Factory Default

Factory Default, Yes/No

Software

Upload Firmware Update

Image Select Software Image Selection
FPGA

Upload FPGA upload

Image Select

FPGA image selection

Configuration

Save Configuration Save
Upload Configuration Upload
Data

CSV Download

CSV download
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5.5 WebLT Menu and Description

Table of Contents

Page
Summary 5-15
Configuration > Alarm 5-17
Configuration > Radio 5-18
Configuration > System > Information 5-19
Configuration > System > IP 5-20
Configuration > System > NTP 5-21
Configuration > System > Log Server 5-22
Configuration > Ports 5-23
Configuration > Security > Switch > Users 5-24
Configuration > Security > Switch > HTTPS 5-26
Configuration > Security > Switch > Access Management 5-27
Configuration > Security > Switch > SNMP > System 5-28
Configuration > Security > Switch > SNMP > RMON > History 5-30
Configuration > Spanning Tree > Bridge Setting 5-31
Configuration > Spanning Tree > CIST Ports 5-32
Configuration > SynckE 5-33
Configuration > Sync 5-35
Configuration > MAC Table 5-36
Configuration > VLAN Translation > Ports to Group Mapping 5-38
Configuration > VLAN Translation > VID Translation Mapping 5-39
Configuration > VLANs > VLANs Membership 5-40
Configuration > VLANs > Ports 5-41
Monitor > Alarm 5-43
Monitor > System > Information 5-44
Monitor > System > Log 5-46
Monitor > Ports > Traffic Overview 5-47
Monitor > Ports > Detailed Statistics Ratio 5-48
Monitor > Security > Access Management Statistics 5-49
Monitor > Security > Switch > RMON > Statistics 5-50
Monitor > Security > Switch > RMON > History 5-52
Monitor > Spanning Tree > Bridge Status 5-53
Monitor > Spanning Tree > Port Status 5-55
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Monitor > Spanning Tree > Port Statistics
Monitor > MAC Table

Monitor > VLANs > VLAN Membership
Monitor > VLANs > VLAN Port

Monitor > Radio Performance > Current

Monitor > Radio Performance > 15 Minutes

Monitor > Radio Performance > 1 Day

Test & Diagnostics > Control
Test & Diagnostics > Ping

Maintenance > Restart Devices
Maintenance > Factory Default
Maintenance > Software > Upload
Maintenance > Software > Image Select
Maintenance > FPGA > Upload
Maintenance > FPGA > Image Select
Maintenance > Configuration > Save
Maintenance > Configuration > Upload

Maintenance > Data > CSV Download

Page
5-56
5-57
5-58
5-59
5-60
5-61
5-62

5-63
5-64

5-65
5-66
5-67
5-68
5-69
5-70
5-71
5-72
5-73

NOTICE: In this section, WebLT menu and screenshot is displayed for
GX4000 Ethernet except for Sync menu of GX4000 CPRI.
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Summary

i (=[5 s

a‘ / ‘| & http://192.168.0.10 L~rECX H @ BroadOne_GX4000 l J {0} .9 503

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summary =
~ Configuration Summary Auto-refresh [C| | Refresh
= Alarm

« Radio Alarm Summary 2013-02-05T04:32:32+00:00
v System
S.ylnformation Category | Status
P Hardware @ Eror
1 [‘JQPServer Radio Warning
= Poris Line Warning Detail Information
w Security
i, Clock @& Normal
» Users Console @ Normal
= HTTPS
= Access Management H :
 SNMP Test&Diagnostics Summary
» Spanning Tree Item Current
Bt Loopback -
G Tanke B8R RO || Operate
» VLAN Translation = P
» VLANS Line pback -
» Monitor ¢
» Test&Diagnostics Configuration Summary
» Maintenance Target Tx Power (dBm) 100
ATPC Disabled
ATPC Target Rx Power (dBm) | -40.0
Route ID 0
BER Alarm Threshold 1.0E-04

Summary Main Frame

Alarm Summary: This menu shows the summary of current alarms.

Category . The category of alarms. The displayed categories are;
Hardware: Related to the hardware
Radio: Related to the Radio interface
Line: Related to the Line interface
Clock: Related to the clock synchronization
Console: Related to the Console interface

Status . The status of current alarms are displayed with 3 levels Error, Warning and info.
Error (indicated with red icon): High level problem. Equipment can not work
correctly, under this condition. Fatal problem happens on internal device or
process.

Warning (indicated with yellow icon): Low level problem. Equipment is working.
However some problem happens on interface of Radio, Line Clock or Console,
otherwise hardware has degradation.

Info (indicated with blue icon): Information except Error and Warning to be
informed to the operator.

If there are no Error, Warning and Info, Normal (indicated with green icon) is
displayed

BroadOne GX4000 Manual (R3.0) issue 1.03 5-15



Web-based LT FUﬁTSU Fujitsu and Fujitsu Customer Use Only

Test & Diagnostics Summary: This menu shows the summary of current condition of Test and

Diagnostics.

Radio loopback : Operation of Loopback for RADIO side.

Radio TX OFF . Operation of shut-off for TX output power.

Line loopback Operation of Loopback for LINE side.

Current . Indicates current condition. The displayed conditions are;

Operate: Operation is active
-: Operation is inactive

Configuration Summary: This menu shows the summary of radio configuration

Target TX power . Current setting of target value for TX output power.

ATPC . Current setting of ATPC. The displayed settings are:
Enabled: ATPC is enabled
Disabled: ATPC is disabled

ATPC target RX power : Current setting of target value for receiving power upon ATPC. If
ATPC is disabled, there is no value.

Route ID : Current setting of root identification number for radio link.

BER Alarm Threshold Current setting of BER alarm threshold for radio link

Auto-refresh . Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds.

Refresh . Click to refresh the page

Detail Information . Click to open the detailed alarm list as shown in Figure 1la below.

O~BCX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] S

= Summary E )
v Configuration Monitor > Alarm Auto-refresh | | Refresh

= Alarm NOS—
« Radio 2013-02-06T07:58:45+00:00
Skl No.| Level | Time [ Category | Condition Description

« Ports
: —— 2013-02-
» Security 1 Waming 46101-22-01+00-00

Hardware Internal Power Source Failure

» Spanning Tree e
= SyncE 2 Warning Sg.}.g 10_31 30+00-00 Radio RS Synchronization Loss
*MAC Table 3 @ Waming 2013-02- T MOD_NR(Module Not Ready (mirroring
» VLAN Translation aming  pgT01:21:21+00:00 ine hardware output pin))
b ! 4 Waming 2013-02- Uina RX_CDR Unlocked(Unlocked:Loss of Lock
= VLAN Membership 9 06T01:21:21+00:00 of RX side CDR)
= _Ft’ons 5 . Info 2013-02- Line RX_LOS(RX Loss of Signal (mirroring
X Mo ox: s 06T01:21:21+00:00 hardware output pin))
» Test&Diagnostics . 2013-02- : RX_NR(Any condition leading to invalid
» Maintenance 6 Waming 0e101:21:21+00:00 Line data on the RX path)
2013-02- )
7 . Error 06T01:21-20+00-00 Hardware 10 Error
2013-02- :
s @ Error 06T01:21-20+00-00 Hardware  Startup Failure
1 @ Info 52%3}9%}:2%00:00 Line Optical Power Received Out of Range
2013-02- : ; :
10 . Info 06T01:21-20+00-00 Line Optical Power Received Degrade

Detailed Alarm List Screen
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Configuration

Configuration > Alarm

.
a' 2 | @ hetp://192.168.0.10

P~rECX H & BroadOne_GX4000

l#J {7 S.¢ tod

= Summary
v Configuration
= Alarm

Fujitsu BroadOne GX4000 Series - Ethernet

Configuration > Alarm

[Nakahara001#:]

= Log Server
= Ports
w Security
w Switch
= Users
= HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

« Radio Optical Link Pass Through | Enabled |v|
v System Optical Link Shutdown Disabled ||
= Information
=P
“NTP Save I Reset

Configuration > Alarm:

Optical Link Pass Through

Optical Link Shutdown

Save Button

Reset Button

Configure > Alarm Menu Frame

The Optical Link Pass Through is the function that carry the
condition of own optical link down to opposite side optical link
through the radio link. Set the Optical Link Pass Through.
Possible settings are:

Enabled: Optical Link Pass Through is enabled

Disabled: Optical Link Pass Through is disabled

The Optical Link Shutdown is the function that automatically
shuts off the optical output according to the loss of radio link.
Set the Optical Link Shutdown. Possible settings are:
Enabled: Optical Link Shutdown is enabled

Disabled: Optical Link Shutdown is disabled

Click to save changes

Click to undo any changes made locally and revert to
previously saved values
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Configuration > Radio

- [E= e

a‘ : ]5\ http://192.168.0.10 p~-BeX H @ BroadOne_GX4000 l J

Fujitsu BroadOne GX4000 Series - Ethernt
[Nakahara001#:]

= Summa
vConﬁgurryation Configuration > Radio

: 3!:;3 Target Tx Power (dBm) 10.0 [~
v System ATPC Disabled E]

= Information ATPC Target Rx Power (dBm)
2 Route ID 0 [
« Log Server BER Alarm Threshold 1.0E-04[~]
= Ports
~ Security
g Save || Reset |
= Users
= HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > Radio Menu Frame

Configuration > Radio:

Target Tx Power : The Target Tx Power is the target TX output power of transmitter.
Set to 0.0 (0 dBm) to 10.0 (+10 dBm) with 0.5 step.
The default value is 10.0 (+10 dBm).

ATPC : The Automatic Transmit Power Control is the function that adjust TX
output power automatically by detecting far-end receiver signal level
(RSL) threshold. Possible settings are:
Enabled: ATPC is enabled
Disabled: ATPC is disabled (default)

ATPC Target :  The ATPC Target Rx Power is target value of far-end RSL threshold when
Rx power ATPC is enabled. Set to -30.0 (-30 dBm) or -40.0 (-40 dBm). The
default value is -40.0 (-40 dBm). If

ATPC is disabled, it cannot activate. Default is -40.

Route ID :  The Route ID is the function that identifies the number for radio link to
detect the interference with undesired radio signals. Same Route ID must
be set on both of equipment that connected by a radio link. If there is
different Route ID, "RF Route ID Fail" happens. Set to 0 to 15.

The default value is 0

BER Alarm . The BER Alarm Threshold is defined the threshold to initiate "Radio BER
Threshold Alarm". Set to 1.0E-03, or 5.0E-04, or 1.0E-04, or 5.0E-05, or 1.0E-05, or
5.0E-06, or 1.0E-06. The default value is 1.0E-04.

Save Button :  Click to save changes
Reset Button : Click to undo any changes made locally and revert to previously saved
values
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Configuration > System

Configuration > System

> Information

.
G‘ 5 I\__;; http://192.168.0.10

P~BLX H & BroadOne_GX4000

< [

= Summary
v Configuration

Configuration > System > Information

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Alarm

= MAC Table

» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

= Radio System Contact Nakahara:
vSystem System Name Nakahara001-2F
1 :r';to_rmg o) System Location Nakahara001#:
= NTP System Timezone Offset (minutes) | 0
e Server Site Code al-2
v Security Equipment Code b-2:
v Switch Local No. c1-2
= Users
» HTTPS Resource State d1-2:
= Access Management - -
» SNMP Equipment Note el-2:
» Spanning Tree Pe—
= SyncE Save || Reset |

Configuration > System > Information

Configuration > System > Information:

System Contact

System Name

System Location

System
Timezone offset

Site Code

Equipment Code

Local Number
Resource State
Equipment Note
Save Button

Reset Button

The textual identification of the contact person. The allowed string length
is 0 to 255 and the allowed content is the ASCII characters from 32 to
126.

An administratively assigned name for this radio system. Allowable
character is a text string drawn from the alphabet (A-Za-z), digits (0-9),
minus sign (-). No space characters are permitted as part of a name. The
first character must be an alpha character. And the first or last character
must not be a minus sign. The allowed string length is 0 to 255.

The physical location of this site (e.g., telephone closet, 3rd floor).
The allowed string length is 0 to 255, and the allowed content is the ASCII
characters from 32 to 126

Provide the time zone offset relative to UTC/GMT. The offset is given in
minutes east of GMT. The valid range is from -720 to 720 minutes.

Site code where equipment is set up, max. 9 alphanumeric characters
Equipment code, maximum 5 alphanumeric characters.

User managed serial number, max. 6 alphanumerical characters

NE release-build status, max. 6 alphanumerical characters
Equipment note, max. 60 alphanumerical characters

Click to save changes

Click to undo any changes made locally and revert to previously saved
values
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Configuration > System > IP

r

a\ )| @ herp://192.168.0.10

£ - B ¢ X || @ Broadone_Gx4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summa
vConﬁgurryation Configuration > System > IP

= Alarm

« Radio Configured | Current

v System DHCP Client Rer
o IP Address | 192.168.0.10 192.168.0.10
« NTP IP Mask 255.255.255.0 255.255.255.0
= Log Server

= Ports IP Router 0.0.00 0.0.0.0

v Security VLAN ID 1 1

w Switch
: gﬁ,eT';S Save || Reset |
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > System > IP

Configuration > System > IP:

Configure the switch-managed IP information on this page. The Configured column is used to
view or change the IP configuration. The Current column is used to show the active IP

configuration.
DHCP Client . Not supported. "Disable" is always set.
IP Address . Set the IP address of this switch in dotted decimal notation.
Default is 192.0.2.1
IP Mask . Set the IP mask of this switch dotted decimal notation.
Default is 255.255.255.0
IP Router . Set the IP address of the router in dotted decimal notation.
Default is 0.0.0.0
VLAN ID : Provide the managed VLAN ID. The allowed range is 1 to 4095.
Default is 1
Note: When functioning, CPRI is not displayed.
Save Button :  Click to save changes
Reset Button :  Click to undo any changes made locally and revert to previously saved

values
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Configuration > System > NTP

7

= Summary
v Configuration
= Alarm
= Radio
v System
» Information
=P
= NTE
= Log Server
= Ports
v Security
w Swilch
= Users
= HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

al )| @ http://192.168.0.10

£ - B ¢ X || @ Broadone_Gx4000

Fujitsu BroadOne GX4000 Series - Ethernet

WELEUETGUIKE:

Configuration > System > NTP

NTP Configuration
Mode Disabled [=]
Server 1
Server 2

Save Reset ]
RTC Manual Set

Current Date:
2013-02-05T05:10:02+00:00

Year | Mon. | Day | Hour | Min. | Sec.

Set Clear

(E s

Configuration > System > NTP

NTP Configuration:

Mode

Serverl/2
Save Button

Reset Button

RTC Manual Set:

Mode

Set

Clear

Indicates the NTP mode operation. Possible modes are:

Enabled: Enable NTP mode operation. When NTP mode operation is
enabled, the agent forwards NTP messages between the clients and the
server when they are not on the same subnet domain.

Disabled: Disable NTP mode operation.

Provide the NTP IPv4 address of this switch. Default is null.
Click to save changes

Click to undo any changes made locally and revert to previously saved
values

Set the date and time.

The input items are:

Year: Input year. (allowed range: 2012-2037)
Mon.: Input month. (allowed range: 1-12)
Day: Input day. (allowed range: 1-31)

Hour: Input hour. (allowed range: 0-23)

Min.: Input minute. (allowed range: 0-59)
Sec.: Input second. (allowed range: 0-59)

Input date and time are set

The input items are emptied
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Configuration > System > Log Server

i e ) [

G‘ [:—) http://192.168.0.10 P~-RLEX H & BroadOne_GX4000 X l ] {1} 3¢ 04

Fujitsu BroadOne GX4000 Series - Ethert
[Nakahara001#:]

=S
vc';':ﬁ";?]rryaﬁon Configuration > System > Log Server

= Alarm
L Fadtio Server Mode Disabled E}
v System Server Address
= Information Syslog Level Error,Warning,Info [ |

- IP
""" Save Reset |

= NTP

= Ports
v Security
w Switch
= Users
= HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > System > Log Server

Configuration > System > Loqg Server:

Server Mode . Indicates the server mode operation. When the mode operation is
enabled, the syslog message will send out to syslog server. The syslog
protocol is based on UDP communication and received on UDP port 514
and the syslog server will not send acknowledgments back sender since
UDP is a connectionless protocol and it does not provide
acknowledgments. The syslog packet will always send out even if the
syslog server does not exist. Possible modes are:
Enabled: Enable server mode operation.
Disabled: Disable server mode operation. (default)

Server Address . Indicates the IPv4 host address of syslog server. If the switch provide
DNS feature, it also can be a host name. Default is null.

Syslog Level : Indicates what kind of message will send to syslog server. Possible
modes are:

Error, Warning, Info: Send information, warnings and errors.
Error, Warning: Send warnings and errors.
Error: Send errors.

Save Button :  Click to save changes
Reset Button . Click to undo any changes made locally and revert to previously saved
values
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Configuration > Port (Only applicable for Ether)

7

ax ]3 http://192.168.0.10

P~BLCX H & BroadOne_GX4000

<

= Summary
v Configuration
= Alarm
= Radio
v System
= Information
=P
=« NTP
= Log Server
= Ports
w Security
w Switch
= Users
= HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

@

Configuration > Ports

Maximum

Port Status | Frame Size
(byte)

Radio (_)Down 10056

Line () Down 10056

Maintenance ¢  Up 10056

Reset l

Configuration > Port

Configuration > Port:

This menu displays current port configurations. Ports can also be configured here.

Port
Status

Maximum Frame
Size

Save Button

Reset Button

Refresh Button

This is the port name for this row

The current link state is displayed graphically. Green indicates the link is
up and no colour that it is down.

Enter the maximum frame size allowed for the switch port, including FCS.
Line port maximum frame size: 1518 to 10056, default is 10056

Radio port maximum frame size: 1518 to 10056, default is 10056
Maintenance port maximum frame size: 1518 to 10056, default is 10056
Click to save changes

Click to undo any changes made locally and revert to previously saved
values.

Click to refresh the page. Any changes made locally will be undone
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Configuration > Security
Configuration > Security > Switch > User

B D‘@ E; B

a\ )| @ hetp//192.168.0.10 pP-BeX H @ BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] W

= Summa
vConﬁgurryaﬁon Configuration > Security > Switch > Users

e User Name [ Privilege Level
= Radio - . - - . - -
v System admin 3:Monitor, Test&Diagnostics, Maintenance,Configuration
e ton monitor 1:Monitor
«IP diag 2:Monitor, Test&Diagnostics
« NTP 1 1:Menitor
= Log Server 1_Monitor 3:Monitor, Test&Diagnostics, Maintenance, Configuration
= Ports a1234567890123456789012345678301  3:Monitor, Test&Diagnostics, Maintenance, Configuration

w Security
- Suten
= Users
» HTTPS
= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics

://192.168.0.10/navbar.htm#

Configuration > Security > Switch > User main Frame

Configuration > Security > Switch > User:

This menu provides an overview of the current users. Currently the only way to login as another
user on the web server is to close and reopen the browser. The displayed values for each user are:

User Name . The name identifying the user. This is also a link to Add/Edit User.
Privilege Level . The privilege level of the user. The allowed range is 1 to 4.

The operation allowed at each privilege level is the following:

1: Monitor

2: Monitor, Test & Diagnostics
3: Monitor, Test & Diagnostics, Maintenance, Configuration
4: Monitor, Test & Diagnostics, Maintenance, Configuration, Telnet

Add New User . Click to add a new user and Add User frame will appear.
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= Summary
v Configuration
= Alarm
= Radio
¥ System
= Information
- IP
« NTP
= Log Server
= Ports
w Security
w Switch

= Access Management
» SNMP
» Spanning Tree
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

(s

Add User
User Settings
User Name
Password
Password (again)
Privilege Level [ 1:Monitor [~

[ Save H Reset H Cancel ]

Add User:

User Name

Password

Password again

Privilege Level

Save button

Reset button

Cancel button

Delete User

Add User Sub Frame

A string identifying the user name that this entry should belong to. The
allowed string length is 1 to 32. The valid user name is a combination of
letters, numbers and underscores.

The password of the user. The allowed string length is 0 to 32.

The privilege level of the user. The allowed range is 1 to 3.
The operation allowed at each privilege level is the following:
1: Monitor

2: Monitor, Test & Diagnostics

3: Monitor, Test & Diagnostics, Maintenance, Configuration

Click to save changes

Click to undo any changes made locally and revert to previously saved
values

Click to undo any changes made locally and return to the Users.

Delete the current user. This button is not available for new configurations
(Add new user)
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Configuration > Security > Switch > HTTPS (Only applicable for Ether)

r

aw || @ http://192.168.0.10

P~ReX H & BroadOne_GX4000

= Summary
v Configuration
= Alarm
= Radio
v System
= Information
L 'P
= NTP
= Log Server
= Ports
w Security
w Switch
= Users

» SNMP

» Spanning Tree

= SyncE

= MAC Table

» VLAN Translation

» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] W

Configuration > Security > Switch > HTTPS

Mode

Automatic Redirect

Enabled
Disabled

v
v

Save Reset

Configuration > Security > Switch > HTTPS:

Mode

Automatic
Redirect

Save button

Reset button

Configuration > Security > Switch > HTTPS Main Frame

Indicates the HTTPS mode operation. When the current connection is
HTTPS, to apply HTTPS disabled mode operation will automatically
redirect web browser to an HTTP connection. Possible modes are:
Enabled: Enable HTTPS mode operation.

Disabled: Disable HTTPS mode operation.

Indicates the HTTPS redirect mode operation. It only significant if HTTPS
mode "Enabled" is selected. Automatically redirects web browser to an
HTTPS connection when both HTTPS mode and Automatic Redirect are
enabled or redirects web browser to an HTTP connection when both are

disabled. Possible modes are:

Enabled: Enable HTTPS redirect mode operation.
Disabled: Disable HTTPS redirect mode operation.

Click to save changes

Click to undo any changes made locally and revert to previously saved

values
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Configuration > Security > Switch > Access Management (only applicable for Ether)
r ' [ESEENE)
a‘ X ‘I\T—) http://192.168.0.10 PL~BLX H @ BroadOne_GX4000 < ‘—J B ok

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] S

= Summa . s <
vConﬁgul;yation Configuration > Security > Switch > Access Management

L [ Mode | Disabled [~ ]|

v System
= Information

=[P
= NTP [ Delete | Start IP Address | End IP Address | HTTP/HTTPS | SNMP

= Log Server

= Ports Add New Entry

v Security

g S:”{‘f;’;,s Save || Reset

R
= Access Management
» SNMP

» Spanning Tree

= SyncE

= MAC Table

» VLAN Translation

» VLANS

» Monitor

http://192.168.0.10/navbar.htm#

Configuration > Security > Switch > Access Management Main Frame

Access Management:

The maximum number of entries is 16. If the application's type match any one of the access
management entries, it will allow access to the switch.

Mode . Indicates the access management mode operation. Possible modes are:
Enabled: Enable access management mode operation.
Disabled: Disable access management mode operation.

Delete . Check to delete the entry. It will be deleted during the next save.

Start IP Address  : Indicates the start IP address for the access management entry.

End IP Address : Indicates the end IP address for the access management entry.

HTTP/HTTPS : Indicates that the host can access the switch from HTTP/HTTPS
interface if the host IP address matches the IP address range provided in
the entry.

SNMP . Indicates that the host can access the switch from SNMP interface if the
host IP address matches the IP address range provided in the entry.

Add New Entry . Click to add a new access management entry.

Save . Click to save changes

Reset . Click to undo any changes made locally and revert to previously saved
values
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Configuration > Security > Switch > SNMP

Configuration > Security > Switch > SNMP > System
™ o
G‘ 3 }5‘ http://192.168.0.10 P~-BCX H & BroadOne_GX4000 . LJ

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= S
.c‘::&::,?aﬁon Configuration > Security > Switch > SNMP > System

: 3’:;2 Mode Enabled [ll
v System Version SNMP v2¢ [=]
. :gfmma“"" Read Community | public
=« NTP Write Community | private
= Log Server
= Ports
v Security i
+ Switch SNMP Trap Configuration
Trap Mode Disabled v
v' g‘;ﬁ’? Management Trap Version SNMP v2c -
= System Trap Community public
§ RMON Trap Destination Address
» Spanning Tree . -
« SyncE Trap Authentication Failure Enabled =]
= MAC Table Trap Link-up and Link-down 'Enabled E
» VLAN Translation Trap Inform Mode Enabled (>
» VLANs Trap Inform Timeout (seconds) | 1
» Monitor ‘
» Test&Diagnostics Trap Inform Retry Times 5
» Maintenance
Save || Reset |

Configuration > Security > Switch > SNMP > System Main Frame

Configuration > Security > Switch > SNMP > System:

Mode : Indicates the SNMP mode operation. Possible modes are:
Enabled: Enable SNMP mode operation.
Disabled: Disable SNMP mode operation.

Version . Indicates the SNMP supported version. Possible versions are:
SNMP v2c: Set SNMP supported version 2c.

Read Community : Indicates the community read access string to permit access to SNMP
agent. The allowed string length is 0 to 255, and the allowed content is
the ASCII characters from 33 to 126.

The field is applicable only when SNMP version is SNMPv2c. It provides
more flexibility to configure security name than a SNMPv2c community
string. In addition to community string, a particular range of source
addresses can be used to restrict source subnet.

Write Community : Indicates the community write access string to permit access to SNMP
agent. The allowed string length is 0 to 255, and the allowed content is
the ASCII characters from 33 to 126.

The field is applicable only when SNMP version is SNMPv2c. It provides
more flexibility to configure security name than a SNMPv2c community
string. In addition to community string, a particular range of source
addresses can be used to restrict source subnet.
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SNMP Trap Configuration:

Trap Mode

Trap Version

Trap Community

Trap Destination
Address

Trap
Authentication
Failure

Trap Link-up and
Link-down

Trap Inform Mode

Trap Inform
Timeout (sec)

Trap Inform Retry
Times

Save

Reset

Indicates the SNMP trap mode operation. Possible modes are:
Enabled: Enable SNMP trap mode operation.
Disabled: Disable SNMP trap mode operation.

Indicates the SNMP trap supported version. Possible versions are:
SNMP v2c: Set SNMP trap supported version 2c.

Indicates the community access string when sending SNMP trap packet.
The allowed string length is 0 to 255, and the allowed content is ASCII
characters from 33 to 126.

Indicates the SNMP trap destination address. It allows a valid IP address
in dotted decimal notation ('X. y. z. w').

Indicates that the SNMP entity is permitted to generate authentication
failure traps. Possible modes are:

Enabled: Enable SNMP trap authentication failure.

Disabled: Disable SNMP trap authentication failure.

Indicates the SNMP trap link-up and link-down mode operation. Possible
modes are:

Enabled: Enable SNMP trap link-up and link-down mode operation.
Disabled: Disable SNMP trap link-up and link-down mode operation.

Indicates the SNMP trap inform mode operation. Possible modes are:
Enabled: Enable SNMP trap inform mode operation.
Disabled: Disable SNMP trap inform mode operation.

Indicates the SNMP trap inform timeout. The allowed range is 0 to 2147.

Indicates the SNMP trap inform retry times. The allowed range is 0 to
255,

Click to save changes

Click to undo any changes made locally and revert to previously saved
values
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Configuration > Security > Switch > SNMP > RMON (Only applicable for Ether)

Configuration > Security > Switch > SNMP > RMON > History

PL~BCEX |I & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] g

=S
vcl;:‘ﬁn;:rryation Configuration > Security > Switch > SNMP > RMON > History

= Alarm

« Radio ID| Port Interval Buckets | puckets
v System
= Information 1 Radio 1800 50 50
i 2 Line 1300 50 50
= Log Server 3 Maintenance 1800 50 50

= Ports

w Securty [ ]
< Switch Save Reset

= Users
= HTTPS
= Access Management
w» SNMP
= System
v RMON
= History

w Spanning Tree
= Bridge Setiings
= CIST Poris

= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > Security > Switch > SNMP > RMON > History Main Frame

Configuration > Security > Switch > RMON > History:

This menu is to configure RMON History table. The entry index key is ID.

ID : Indicates the index of the entry. The range is from 1 to 65535

Port : Indicates the port name which wants to be monitored

Interval : Indicates the interval in seconds for sampling the history statistics data. The
range is from 1 to 3600, default value is 1800 seconds.

Buckets : Indicates the maximum data entries associated this History control entry stored in
RMON. The range is from 1 to 3600, default value is 50.

Buckets Granted : The number of data shall be saved in the RMON

Save Click to save changes

Reset Click to undo any changes made locally and revert to previously saved
values
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Configuration > Spanning Tree (Only applicable for Ether)

Configuration > Spanning Tree > Bridge Setting

* Summary
¥ Csrmiguranen
Y=

Praturul Varsdan
Bisdye Frieeity
Foawand Dalay
Nax Age E
Masbaiim Wap Count |
Trammnit Mald Comt | -

Configuration > Spanning Tree > Bridge Settings

Fujitsu BroadOne GX4000 Series - Ethernet
[Ether70G-3)

¥ Mannar
} TestADuagmosnes Edge ot BEDU Fitieiing

» Maintenance Edge Part BPDU Guurd

Putt Errar Recoavmiy

[Gww | [Fmwnt

Purt Errwt Racavery Timso

Configuration > Spanning Tree > Bridge Setting Main Frame

Configuration > Spanning Tree > Bridge Setting: This menu allows you to configure STP

system settings. The settings are used by all STP Bridge instances in the Switch

Basic Setting:
Protocol Version

Bridge Priority

Forward Delay

Max Age

Maximum Hop
Count

Transmit Hold
Count

The STP protocol version setting. Valid values are STP & RSTP
Default is STP.

Controls the bridge priority. Lower numeric values have better priority.
The bridge priority plus the MSTI instance number, concatenated with the
6-byte MAC address of the switch forms a Bridge Identifier.

The delay used by STP Bridges to transit Root and Designated Ports to
Forwarding (used in STP compatible mode). Valid values are in the range
4 to 30 seconds. Default is 15.

The maximum age of the information transmitted by the Bridge when it is
the Root Bridge. Valid values are in the range 6 to 40 seconds, and Max
Age must be <= (FwdDelay-1)*2. Default is 20.

This defines the initial value of remaining Hops for MSTI information
generated at the boundary of an MSTI region. It defines how many
bridges a root bridge can distribute its BPDU information to. Valid values
are in the range 6 to 40 hops. Default is 20.

The number of BPDU's a bridge port can send per second. When
exceeded, transmission of the next BPDU will be delayed. Valid values
are in the range 1 to 10 BPDU's per second. Default is 6.
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Advanced Setting:

Edge Port BPDU : Control whether a port explicitly configured as Edge will transmit and

Filtering receive BPDUs. Default is not clicking.

Edge Port BPDU : Control whether a port explicitly configured as Edge will disable itself

Guard upon reception of a BPDU. The port will enter the error-disabled state,
and will be removed from the active topology. Default is not clicking.

Port Error : Control whether a port in the error-disabled state automatically will be

Recovery enabled after a certain time. If recovery is not enabled, ports have to be

disabled and re-enabled for normal STP operation. The condition is also
cleared by a system reboot. Default is not clicking.

Port Error . The time to pass before a port in the error-disabled state can be enabled.

Recovery Valid values are between 30 and 86400 seconds (24 hours).

Timeout Default is null.

Save Click to save changes

Reset Click to undo any changes made locally and revert to previously saved
values

Configuration > Spanning Tree > CITS Ports

G‘ )| @ htrp://192.168.0.10

™

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

P~EBCX H & BroadOne_GX4000

= Summary
v Configuration
= Alarm

Configuration > Spanning Tree > CIST Ports

* Radio CIST Normal Port Configuration
» System STP
+pors 3 Port | Enabled
3 uri . =
v Spanning Tree Rafj'o ‘j

= Bridge Settings Line [
} S.y(r:IIch Ports Maintenance ]

= MAC Table

: msﬁanslaﬁon Save | M|

» Monitor
» Test&Diagnostics
» Maintenance

Configuration > Spanning Tree > CIST Ports Main Frame

Spanning Tree > CIST Ports: This menu allows the user to inspect the current STP CIST
port configurations, and possibly change them as well. This menu contains settings for physical
and aggregated ports.

Port : The port name of the logical STP port

STP Enables . Controls whether STP is enabled on this port

Save . Click to save changes

Reset CIilck to undo any changes made locally and revert to previously saved
values
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Configuration > Synck (Only applicable for Ether)

— J D-R[CX i| & BroadOne_GX4000 | |

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

* Summary 2
» Configuration Configuration > SyncE Rafrash
« Alarm

« Radio Note The configuraions on this page are saved in the flash memary. but can not be saved to a XML fils which is downloadad by
n “Maintenance > Configuration > Save"
» System
+ Ports Clock Source Nomination and State
» Secunity
b Spanning Tree wmmmmmn
« SyncE . 2 3 = - ',.
» MAC Tahle ! Line OL NONE|»|  Disabied none =
» VLAN Transistion 2 Radio . QLNONE[s]  Disabled . ¢ ; none =]
» VLANS
» Monitor Clock Selection Mode and State
» TesthDiagnostics
» Maintenance Mode lsamlml | State | Clock Source | LOL
[ Forcad Free Run | = 1] & |- QL NONE |« QL NONE | » [ Free Run L2
é_ave | Rasot
SyncE Ports
s e
Radio

Line

Configuration > SyncE Main Frame

Clock Source Nomination and Status:

Clock Source . This is the instance number of the clock source. This has to be
referenced when selecting ‘Manual' Mode

Nominated . When a clock source is nhominated, the clock output from the related PHY
(Port) is enabled against the clock controller. This makes it available as a
possible source in the clock selection process.

Port . The ports that are possible to select for this clock source, is presented.

Priority : The priority for this clock source. Lowest number (0) is the highest
priority. If two clock sources have the same priority, the lowest clock
source number gets the highest priority in the clock selection process.
(Future support)

SSM Overwrite . A selectable clock source Quality Level (QL) to overwrite any QL received
in a SSM. If QL is not Received in a SSM (SSM is not enabled on this
port), the SSM Overwrite QL is used as if received. The SSM Overwrite
can be set to QL_NONE, indicating that the clock source is without any
know quality (Lowest compared to clock source with known quality)

Hold Off :  The Hold Off timer value. Active loss of clock Source will be delayed the
selected amount of time. The clock selector will not change clock source
if the loss of clock condition is cleared within this time (Future support)

LOCS :  Signal is lost on this clock source

SSM . If SSM is enabled and not received properly. Type of SSM fail will be
indicated in the 'Rx SSM' field

WTR :  Wait To Restore timer is active.

Clear WTR . Clears the WTR timer and makes this clock source available to the clock

selection process.
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Clock Selection Mode and Status

Mode

Source

WTR Time

SSM Holdover

SSM Free Run

Status

Clock Source
LOL

SyncE Port
Port

SSM Enabled
TX SSM

RX SSM

Refresh
Save

Reset

The definition of the 'best’ clock source is firstly the one with the highest
(QL) and secondly (the ones with equal QL) the highest priority. Clock
Selector can be in different modes:

Manual: Clock selector will select the clock source stated in Source (see
below). If this manually selected clock source is failing, the clock selector
will go into holdover state.

Force Hold Over: Clock Selector is forced to Free Run State.

Force Free Run: Clock Selector is forced to Free Run State.

The mode transition from "Force Free Run" to "Force Hold Over" is not
allowed (The message of INVALID_PARAMETER is displayed).

(Default is Force Free Run.)

Only relevant if Manual mode is selected (see above).

1: Line and 2: Radio (default is 1.)

Wait To Restore timer value in minutes. The WTR time is activated on the
falling edge of a clock source failure. This means that the clock source is
first available for clock selection after WTR Time (can be cleared).

Set WTR Time from Disable, 1M to 12M, 1 minute step.

Transmitted SSM QL value when clock selector is in Hold Over State.
Set SSM Holdover from QL NONE, QL PRC, QL SSUA, QL SSUB, QL
ECC2, QL ECC1, QL DNU and QL INV. (Default is QL NONE.)

This is the transmitted SSM QL value when clock selector is in Hold Over
State. Set SSM Free Run from QL NONE, QL PRC, QL SSUA, QL SSUB,
QL ECC2, QL ECC1, QL DNU and QL INV. (Default is QL NONE.)

This is indicating the state of the clock selector. Possible states are:

Free Run: There are no external clock sources to lock to (unlocked state).
The Clock Selector has never been locked to a clock source long enough
to calculate the hold over frequency offset to local oscillator. The frequency
of this node is the frequency of the local oscillator.

Hold Over: There are no external clock sources to lock to (unlocked state).
The Clock Selector has calculated the holdover frequency offset to local
oscillator. The frequency of this node is hold to the frequency of the clock
source previous locked to.

Locked: Clock selector is locked to the clock source indicated (See next).
The clock source locked to when clock selector is in locked state.

Clock selector has raised the Los Of Lock alarm

The port number to configure.
Enable and disable of SSM functionality on this port.

Monitoring of the transmitted SSM QL on this port. Transmitted QL should
be the Quality Level of the clock generated by this node. This means the
QL of the clock source this node is locked to

Monitoring of the received SSM QL on this port. If link is down on port,
QL_LINK is indicated. If no SSM is received, QL_FAIL is indicated

Click to refresh the page
Click to save changes

Click to undo any changes made locally and revert to previously saved
values
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Configuration > Sync (Only applicable for CPRI)

P~RBCX H 2 BroadOne_GX4000 ]

=~

Fujitsu BroadOne GX4000 Series - CPRI
[Nakahara001#:]

= Summary .
~ Configuration Configuration > Sync Refresh |
= Alarm

* Radio Note: The configurations on this page are saved in the flash memory, but can not be saved to a XML file
» System which is downloaded by "Maintenance > Configuration > Save™.
4 ‘;’y?ﬁg"ty Clock Source Nomination and State
» Monitor ] Clock Source | Nominated | Port | | LOCS
» Test&Diagnostics 1 A Line
» Maintenance -
2 M Radio L

Clock Selection Mode and State

Mode [ Source | | State | Clock Source | LOL
undefined 1 B Free Run
Save ‘ Reset |

Configuration > Sync Main Frame

Clock Source Nomination and Status:
This menu allows the user to inspect and configure the current Sync port settings.

Clock Source : This is the instance number of the clock source. This has to be referenced when
selecting ‘Manual' Mode

Nominated : When a clock source is nominated, the clock output from the related PHY (Port) is
enabled against the clock controller. This makes it available as a possible source
in the clock selection process.

Port . The ports that are possible to select for this clock source, is presented.
LOCS . Signal is lost on this clock source
Clock Selection Mode and Status

Mode . The definition of the 'best' clock source is firstly the one with the highest
(QL) and secondly (the ones with equal QL) the highest priority.

Clock Selector can be in different modes:

Manual: Clock selector will select the clock source stated in Source (see
below). If this manually selected clock source is failing, the clock selector
will go into holdover state.

Source . The clock source locked to when clock selector is in locked state

Clock Source :  The clock source locked to when clock selector is in locked state.

LOL . Clock selector has raised the Los Of Lock alarm.

Refresh . Click to refresh the page immediately

Save . Click to save changes

Reset : CIilck to undo any changes made locally and revert to previously saved
values.
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Configuration > MAC Table (Only applicable for Ether)

= | B [l |

L~BOX H & BroadOne_GX4000

<l

= Summary
v Configuration
= Alarm
= Radio
» System
= Ports
» Security
» Spanning Tree
= SyncE

* MAC Table
» VLAN Translation
» VLANS

» Monitor

» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet

Aging Configuration

Configuration > MAC Table

[Nakahara001#:]

Disable Automatic Aging |/ |

Aging

Time 300 seconds|

MAC Table Learning

Port Members
Maintenance[Line|Radio
Auto @ 5 o
Disable
Secure

Static MAC Table Configuration

Port Members

|
Delete | VLAN ID [ MAC Address |Maintenance|Line|Radio

[ Add New Static Entry }

Save || Reset |

Aging Configuration:

Configuration > MAC Table Main Frame

By default, dynamic entries are removed from the MAC table after 300 seconds. This removal is
also called aging. Configure aging time by entering a value here in seconds:

Aging Time

Disable
Automatic Aging

MAC Table Learning:

Setting range is 10 to 1000000.

Disable automatic aging of dynamic entries by checking. Default is not checking.

If the learning mode for a given port is grayed out, another module is in control of the mode, so
that it cannot be changed by the user. An example of such a module is the MAC-Based
Authentication under 802.1X. Each port can do learning based upon the following settings:

Auto

Disable

Secure

Learning is done automatically as soon as a frame with unknown SMAC
is received. (default)

No learning is done

Only static MAC entries are learned, all other frames are dropped.

Note: Make sure that the link used for managing the switch is added to

the Static Mac Table before changing to secure learning mode, otherwise
the management link is lost and can only be restored by using another
non-secure port or by connecting to the switch via the serial interface.
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Static MAC Table Configuration:

The static entries in the MAC table are shown in this table. The static MAC table can contain 64
entries. The MAC table is sorted first by VLAN ID and then by MAC address.

Delete . Check to delete the entry. It will be deleted during the next save.

VLAN ID :  The VLAN ID of the entry.

MAC Address :  The MAC address of the entry.

Port Member . Checkmarks indicate which ports are members of the entry. Check or
uncheck as needed to modify the entry.

Adding a New Click to add a new entry to the static MAC table. Specify the VLAN ID,

Static Entry MAC address, and port members for the new entry. Click "Save".

Save . Click to save changes

Reset : Clilck to undo any changes made locally and revert to previously saved
values
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Configuration > VLAN Translation (Only applicable for Ether)

Configuration > VLAN Translation > Port to Group Mapping

P~BCX H & BroadOne_GX4000 » l o7 S 4o

= Summary
v Configuration
= Alarm
= Radio
» System
= Ports
» Security
» Spanning Tree
= SyncE
= MAC Table
vVLAN Translation
= Port to Group Mapping

» VID Translation
Mapping
» VLANS
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > VLAN Translation > Port to Group Mapping Auto-refresh [C] | Refresh

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Port Members

Group ID

Maintenance|Line |Radio|

)

°

Add New Entry
Save || Reset

Configuration > VLAN Translation > Port to Group Mapping Main Frame

Port to Group Mapping:

Group ID

Port Member

Adding a New
Entry

Save

Reset

Auto-refresh

A valid Group ID is an integer value from 1 to 29. A set of VLAN
Translations are mapped to a group Id. This way a port is mapped to a list
of VLAN Translations easily by mapping it to a group. Number of groups
in this switch is equal to the number of ports (29) present in this switch. A
port can be mapped to any of the groups. Multiple ports can also be
mapped to a group with same group Id.

Note: By default, each port is mapped to a group with a group Id equal to
the port number. For example, port 1 is mapped to the group with ID=1.

A row of radio buttons, one radio button for each port is displayed for
each Group ID. To include a port in a Group, click the radio button. A port
must belong to at least one group.

Click Add New Entry to add a new entry in Port to Group Mapping Table.
An empty row is added to the table with the Group ID and array of radio
buttons, one radio button for each port (click corresponding radio button
to make port to be member of a particular Group). Legal values for a
VLAN ID are 1 through 4095. The Delete button can be used to undo the
addition of new entry.

Click to save changes

Click to undo any changes made locally and revert to previously saved
values

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds
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Configuration > VLAN Translation > VID Translation Mapping

k& |:—} P~-BeX H & BroadOne_GX4000 . l l ke

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

=S
vc‘o‘:‘f'i::rryaﬁon Configuration > VLAN Translation > VID Translation Mapping Auto-refresh [] | Refresh |

= Delete | Group ID [VLANID [ Transiated to VID

» System No VLAN Translation entry found
= Ports

» Security Add New Entry |
» Spanning Tree

= SyncE Save || Reset |
= MAC Table

¥ VLAN Translation

= Port to Group Mapping
= ¥ID Translation
Mapping
» VLANs
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > VLAN Translation > VID Translation Mapping Main Frame

VID Translation Mapping: This menu allows you to map VLAN ID to other VLAN ID for a
particular Group ID Globally

Delete To delete a VLAN Translation Group database entry, check this box. The
entry will be deleted on the switch during the next Save
Group ID : Avalid Group ID is an integer value from 1 to 29. A set of VLAN

Translations are mapped to a group Id. This way a port is mapped to a list
of VLAN Translations easily by mapping it to a group. Number of groups
in a switch is equal to the number of ports present in this switch. A port
can be mapped to any of the groups. Multiple ports can also be mapped
to a group with same group Id.

Note: By default, each port is mapped to a group with a group Id equal to
the port number. For example, port 1 is mapped to the group with ID=1.

VLAN ID : Indicates the ID to which Group ID will be mapped. A valid VLAN ID
ranges from 1-4095.

Translated to VID : Indicates the VID to which VLAN ID of ingress frames will be changed, if
VID in incoming frames if same as configured in VLAN ID field preceded
by this field on member ports of a particular group to which this entry
belongs. Setting range is 1 to 4095 and default is null.

Adding a new . Click Add New Entry to add a new entry in VLAN Translation table. An

VID Translation empty row is added to the table, the Group ID, VLAN ID and Translated to

entry VID fields can be configured as needed. Legal values for a VLAN ID are 1
through 4095. The Delete button can be used to undo the addition of new
entry.

Auto-refresh . Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Refresh . Click to refresh the page immediately

Save :  Click to save changes

Rest :  Click to undo any changes made locally and revert to previously saved
values
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Configuration > VLANs (Only applicable for Ether)

Configuration > VLANs > VLAN Membership

P

E
e

P~BCX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

=S
.c';ﬂ',;::?aﬁo,, Configuration > VLANs > VLAN Membership Refresh | [ << |[ >> |

= Alarm
= Radio Start from VLAN 1 with 20 entries per page.
» System
= Ports | Port Members
» Security Delete [ VLANID | VLAN Name [Maintenance|Line[Radio
> gganging Tree m 1 default M
= Sync =
«MAC Table 2 1abc5 Em &= O
» VLAN Translatiort RO
v VLANS Add New VLAN

= VLAN Membership

= Ports A
ot Save || Reset |

» Test&Diagnostics
» Maintenance

Configuration > VLANs > VLAN Membership Main Frame

VLANs Membership:

The VLAN membership configuration for the switch can be monitored and modified here. Up to
4096 VLANSs are supported. This page allows for adding and deleting VLANSs as well as adding
and deleting port members of each VLAN.

Navigating the VLAN Table:

Each page shows up to 99 entries from the VLAN table, default being 20, selected through the
"entries per page" input field. When first visited, the web page will show the first 20 entries from the
beginning of the VLAN Table. The first displayed will be the one with the lowest VLAN ID found in
the VLAN Table.

The "VLAN" input fields allow the user to select the starting point in the VLAN Table. Clicking the
Refresh button will update the displayed table starting from that or the closest next VLAN Table
match. The >> will use the last entry of the currently displayed VLAN entry as a basis for the next
lookup. When the end is reached the text "No more entries" is shown in the displayed table. Use
the I<< button to start over.

Delete . To delete a VLAN entry, check this box. The entry will be deleted during
the next Save

VLAN ID : Indicates the ID of this particular VLAN

VLAN Name : Indicates the name of the VLAN. Maximum length of the VLAN Name

String is 32 and default is null. VLAN Name can only contain alphabets or
numbers. VLAN name should contain at least one alphabet. VLAN name
can be edited for the existing VLAN entries or it can be added to the new
entries. But maximum number of VLANs which can have Names is 64.

Port Members . Arow of check boxes for each port is displayed for each VLAN ID.
To include a port in a VLAN, check the box as .
To include a port in a forbidden port list, check the box as shown .
To remove or exclude the port from the VLAN, make sure the box is
unchecked as shown ] .
By default, no ports are members, and for every new VLAN entry all
boxes are unchecked.
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Adding a New . Click Add New VLAN to add a new VLAN ID. An empty row is added to
VLAN the table, and the VLAN can be configured as needed. Legal values for a
VLAN ID are 1 through 4095.

The VLAN is enabled when you click on "Save". The Delete button can
be used to undo the addition of new VLANS.

Save . Click to save changes

Reset . Click to undo any changes made locally and revert to previously saved
values

Refresh . Refreshes the displayed table starting from the "VLAN ID" input fields

I<< . Updates the table starting from the first entry in the VLAN Table, i.e. the
entry with the lowest VLAN ID

>> . Updates the table, starting with the entry after the last entry currently
displayed

Configuration > VLANs > Port

O~BCEX H @ BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summary )
v Configuration Configuration > VLANs > Ports Auto-refresh [C] | Refresh
= Alarm

: Radio Ethertype for Custom S-ports 0x 88A8

» System

% Ingress Frame Port VLAN

3 gglgjmy Port Port Type Filtering Type Mode | 1D Tx Tag

» Spanning Tree Radio |Unaware E] [ All E] Specific B 1 | Untag_pvid E]
= SyncE Line |Unaware [~] [ All [+] |Specific[~] 1 |Untag_pvid[~|
; VMCfNT?giﬁslalion Maintenance | Unaware [:ﬂ [ All E] Specific B 1 | Untag_pvid E]

v VLANS

= VLAN Membership Save || Reset |

= Ports
» Monitor
» Test&Diagnostics
» Maintenance

Configuration > VLANs > Port Main Frame

Configuration > VLANs > Ports: This menu is used for configuring the switch port VLAN

Ethertype for Custom S-port 0x...: This field specifies the ether type used for Custom
S-ports. This is a global setting for all the Custom S-ports

Port . The port name in the same row.

Port Type . Port can be one of the following types: Unaware, Customer port (C-port),
Service port(S-port), Custom Service port(S-custom-port).
If Port Type is Unaware, all frames are classified to the Port VLAN ID and
tags are not removed. Default is Unaware.
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Ingress Filtering

Frame Type

Port VLAN Mode

Port VLAN ID

Tx Tag

Auto-refresh

Save

Rest

Enable ingress filtering on a port by checking the box. This parameter
affects VLAN ingress processing. If ingress filtering is enabled and the
ingress port is not a member of the classified VLAN of the frame, the
frame is discarded. By default, ingress filtering is disabled (no
checkmark). Default is no checkmark.

Determines whether the port accepts all frames or only tagged/untagged
frames. This parameter affects VLAN ingress processing. If the port only
accepts tagged frames, untagged frames received on the port are
discarded. By default, the field is set to All. Default is All.

Configures the Port VLAN Mode. The allowed values are None or
Specific. This parameter affects VLAN ingress and egress processing.

If None is selected, a VLAN tag with the classified VLAN ID is inserted in
frames transmitted on the port. This mode is normally used for ports
connected to VLAN aware switches.

If Specific (default value) is selected, a Port VLAN ID can be configured
(see below). Untagged frames received on the port are classified to the
Port VLAN ID. If VLAN awareness is disabled, all frames received on the
port are classified to the Port VLAN ID. If the classified VLAN ID of a
frame transmitted on the port is different from the Port VLAN ID, a VLAN
tag with the classified VLAN ID is inserted in the frame.

Configures the VLAN identifier for the port. The allowed values are 1
through 4095. Default value is 1.

Note: The port must be a member of the same VLAN as the Port VLAN
ID.

Determines egress tagging of a port.

Untag_pvid - All VLANs except the configured PVID will be tagged.
Tag_all - All VLANSs are tagged.

Untag_all - All VLANSs are untagged. Default is Untag_pvid.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Click to save changes

Click to undo any changes made locally and revert to previously saved
values
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Monitor

Monitor > Alarm

)| @ htep://192.168.0.10

DO~ B¢ X|| & Broadone_GX4000

= Summary
» Configuration
v Monitor

» System

» Ports

» Security

» Spanning Tree

= MAC Table

» VLANS

» Radio Performance
» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Monitor > Alarm

Auto-refresh [

2013-02-05T08:52:59+00:00

No.| Level | Time | Category | Condition Description
. 2013-02- )
1 Warning 05TD8:16-36+00-00 Hardware  Internal Power Source Failure
. 2013-02- . -
2 Warning 05T08:16-05+00-00 Radio RS Synchronization Loss
3 Warni 2013-02- Li MOD_NR(Module Not Ready (mirroring hardware
aming  p5T08:15:56+00:00 ine output pin)}
. 2013-02- n RX_CDR Unlocked(Unlocked:Loss of Lock of RX side
4 Waming hrrnsi556+00-00 iz CDR)
2013-02- . RX_LOS(RX Loss of Signal (mirroring hardware output
: @ Info h5T03:15-56+00-00 Line pin))
6 Warni 2013-02- Li RX_NR{Any condition leading to invalid data on the RX
aming  p5708:15:56+00:00 ine path)
2013-02-
7 . Error 05T08:15:55+00-00 Hardware 1O Error
8 @  Emor 2013-02- Hardware  Startup Failure
05T08:15:55+00:00
9 @ Info ﬁg'}gé[]:$:5:55+1}0:00 Line Optical Power Received Out of Range
2013-02- n . .
10 . Info 05T08:15:55+00-00 Line Optical Power Received Degrade

Monitor > Alarm Menu Frame

Monitor > Alarm:

No.

Level

Time

Category

Condition Description

Auto-refresh

Refresh Button

The line number of the table.

The level of the severity of the alarm.

Error (indicated with red icon): High level problem. Equipment
can not work correctly, under this condition. Fatal problem
happens on internal device or process.

Warning (indicated with yellow icon): Low level problem.
Equipment is working. However some problem happens on
interface of Radio, Line Clock or Console, otherwise hardware
has degradation.

Info (indicated with blue icon): Information except Error and
Warning to be informed to the operator.

The occurrence time of the alarm.

The category of alarms. The displayed categories are:
Hardware: Related to the hardware.

Radio: Related to the Radio interface.

Line: Related to the Line interface.

Clock: Related to the Line interface.

Console: Related to the Console interface.

Indicates the description of the alarm.

Check this box to refresh the page automatically. Automatic
refresh occurs every 3 seconds.

Click to refresh the page
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Monitor > System

Monitor > System > Information

&

| @ hrtp://192.168.0.10

= Summary
» Configuration
v Monitor
= Alarm
v System
= Information
CRE]
» Poris
» Security

» Spanning Tree
= MAC Table

» VLANS

» Radio Performance
» Test&Diagnostics
» Maintenance

Fujitsu BroadOne GX4000 Series - Ethernet

P~-BCX || & BroadOne_GX4000

[Nakahara001#:]

Monitor > System > Information

System

Contact Nakahara:
Name Nakahara001-2F
Location Nakahara001#:
Site Code al-2:
Equipment Code b-2:
Local No. cl-2:
Resource State d1-2:
Equipment Note el-2:

Hardware
MAC Address 5c-9a-dB-36-af-1b
System Name BroadOne GX4480
System No TA04010-B936
System Version 020AA
The date of manufacture 20120401
Serial Number 000000012345
CPLD Version VO0LD3

Time

System Date

2013-02-05T08:59:10+00:00

System Uptime 0d 00:43:20
Software
ACT Version V01L01C06-01a
STBY Version V01L51C06-01a
FPGA
ACT Version V0OL05C00
STBY Version VO0OL05C00

Auto-refresh [ | Refresh

Monitor > System > Information Menu Frame

Monitor > System > Information:

Contact

Name

Location

Site Code

Equipment Code

Local No.

Resource State

Equipment Note

MAC Address
System Name

System No.

The system contact configured in Configuration | System | Information |
System Contact.

The system name configured in Configuration | System | Information |
System Name.

The system location configured in Configuration | System | Information |
System Location

The site code configured in Configuration | System | Information | Site
Code.

The equipment code configured in Configuration | System | Information |
Equipment Code.

The local number configured in Configuration | System | Information |
Local No.

The local number configured in Configuration | System | Information |
Resource State.

The equipment note configured in Configuration | System | Information |
Equipment Note.

The MAC Address of this switch.
It is a name of the system.

Itis a chart number of the system.
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System Version
Date of Manufacture
Serial Number
CPLD Version
System Date

System Uptime
Software ACT Version
Software STBY Version
FPGA ACT Version
FPGA STBY Version

Auto-refresh

Refresh Button

It is a version of the system.

It is date of manufacture

Itis a serial number of manufacturing
It is a version of CPLD.

The current (GMT) system time and date. The system time is
obtained through the Timing server running on the switch, if
any.

The period of time the device has been operational.
It is a version of Software on the ACT side.

It is a version of Software on the STBY side.

Itis a version of FPGA on the ACT side.

Itis a version of FPGA on the STBY side.

Check this box to refresh the page automatically. Automatic
refresh occurs every 3 seconds.

Click to refresh the page
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Monitor > System > Log

-

a |5; http://192.168.0.10 P-E2CX || & BroadOne_GX4000 | |

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summal .
>00nﬂgurr];tion Monitor > System > Log Auto-refresh [C] ’ Refresh ” Clear ” |e< ” << ” >3 ” >3 ]
+ Monitor
aiam Level All [~
~ System Category | All [~]
= Information
= Log The tatal number of enfries is 21 for the given level.
» Ports
» Security Start from 1D 1 with 100 entries per page.
3 Spannlng Tree
:MAC Zable ID] Level | Time [ Category | Message
S 2013-02- oy
X -; R:l:g} Perfor;r_]ance 1 . Info 05T08:15:51400:00 Software Switch just made a cold boot. c
ES_ lagnostics 2013-02- . .
» Maintenance 2 . Info 05T08:15-53+00.00 Software Link up on Line
2013-02- . \
3 . Info 05708 1553+00-00 Software Link up on Radio
2013-02- F ALM Occured, Code:0xB300, Optical Power Received
4 @ P §ernal665400-00 he Degrade
5 . Info 2013-02- Line ALM Occured, Code:0xB301, Optical Power Received
05T08:15:55+00:00 Out of Range
6 @  Ermor gg-}géﬁ_s:ssﬂm:uu Hardware  ALM Occured, Code:0x2208, Startup Failure,
2013-02- i )
7 . Error 05T08:15:55400:00 Hardware  ALM Occured, Code:0x2209, Startup Failure, b
2013-02- i .
8 . Error 05T08:15-55+00.00 Hardware  ALM Occured, Code:0xEQ00, Startup Failure,
s @ Error égjl'géﬂ:?é:SSH}U:UD Hardware  ALM Occured, Code:0xBC03, 10 Error
o 2013-02- . ALM Occured, Code:0x8004, XFP RX_NR(Any condition
L Warning  5708.15-66+00-00 A leading to invalid data on the RX path), Line
11 . Info 2013-02- Lina ALM Occured, Code:0x8005, XFP RX_LOS{RX Loss of
05T08:15:56+00:00 Signal(mirroring hardware output pin}), Line
12 Warni 2013-02- Li ALM Occured, Code:0x8006, XFP RX_CDR Unlocked
aming - n5T08:15:56+00:00 ine {Unlocked:Loss of Lock of RX side COR), Line
. 2013-02- . ALM Occured, Code:0x8007, XFP MOD_NR(Module Mot
13 Warning 05T08:15:56+00:00 Line Ready(mirroring hardware output pin)), Line %

Monitor > System > Log Menu Frame

Monitor > System > LoqQ:

ID . The ID (>= 1) of the system log entry.

Level . The level of the system log entry. The following level types are supported:
Info: Information level of the system log.
Warning: Warning level of the system log.
Error: Error level of the system log.
All: All levels.

Time . The time of the system log entry.

Category . The category of the system log. The following kind of categories are
supported:
Software
Hardware
Radio
Line
Clock
Console
All

Message . The message of the system log entry
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Auto-refresh : Check the box to refresh the page automatically. Automatic refresh occurs
every 3 seconds.

Refresh . Update the system log entries, starting from the current entry ID.

Clear . Flushes the selected log entries.

I<< . Update the system log entries, starting from the first available entry ID.

<< . Update the system log entries, starting from the last entry currently displayed.

>> . Updates the system log entries, starting from the last entry currently
displayed.

>>| . Updates the system log entries, starting from the last available entry ID

Monitor > Port (Only applicable for Ether)

Monitor > Port > Traffic Overview

Pe BOX

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Auno-retash

Reliesh Cwar

ot kets T 1 Errors I Filtered

» System J Received | Transmitted | Recelved Received | Transmitted | Received | Transmitted

~ Posets Rade ] 136 0 46145 0 [] 0 ] 0
« Traffc Overoew Lns 0 28 0 LGN 0 0 ] 0 ]
« Dutalind Stahshon Mantangnce 1165 602 292273 115346 0 0 137 0 1164

» Security

» Spanning Tree

o« MAC Tabie

» VLANS

» Radlg Performance

» TestdDiagnostics
» Maintenance

Monitor > Port > Traffic Overview Menu Frame

Monitor > Ports > Traffic Overview: This menu provides an overview of general traffic
statistics for all switch ports

Port . The port for the settings contained in the same row.
Packets : The number of received and transmitted packets per port.
Bytes : The number of received and transmitted bytes per port.
Errors :  The number of frames received in error and the number of incomplete
transmissions per port.
Drops :  The number of frames discarded due to ingress or egress congestion.
Filtered : The number of received frames filtered by the forwarding process.
Refresh . Click to refresh the page immediately
Clear . Clears the counters for all ports
Auto-refresh : Check this box to enable an automatic refresh of the page at regular
intervals
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Monitor > Port > Detailed Statistics Ratio

.
»
-

»
»

=1 -
& i //192.168.0.10 | P« BCX | & BroodOne_GX4000 b
Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]
cm.,m,o,, Monitor > Ports > Detailed statistics Radio Rade [o] Auto-refrash Refresh | | Claar
oo Total I Transmit Total
» System Rx Packets 0 Tx Packets 136 |
- Ports Rx Octats 0 TaOctets 45145
< Tralic Overvisw Rx Unicast 0 Tx Unicast 0
« Destafiod Statrrhes Rx Musticast 0 TxMulticast 100
» Security Rx Broadcast 0 Tx Broadcast 36
» ‘3p$nmnq Tree Rx Pause 0 Tx Pause [
» MAC Tatte Receive Size Counters : Transmit Size Counters |
» VLANS Rx 64 Bytes 0 Tx 64 Bytes 1"
S Ratio Ferommance Rx 65127 Bytes 0 Ta85.127 Bytes 38
TestADiagnostics Rx 128-255 Bytes 0 Tx 128.255 Bytes 1"
Nttt fx 256511 Bytes 0 Tx25.511 Bys 3
Rx 5121023 Bytes 0 Tx512-102) Bytes 15
Rx 10241526 Bytes 0 Ta1024.1526 Byws 0
Rx 1527. Bytes 0 Tx 1527. Bytes 0
Recwive Error Counters 1 Transmit Error Counters
Rx Drops G TxDrops 0
Rx CRCIAlgnment 0 Txlmtefxc. Coll 0
ix Undarsize 0
Rx Oversiee 0
Rx Fragments 0
Rx Jabber 0
Rx Fidered 0

Monitor > Port > Detailed Statistics Ratio Menu Frame

Rx and Tx Total:

This menu provides detailed traffic statistics for a specific switch port. Use the port select box to select
which switch port details to display. The displayed counters are the totals for receive and transmit, the
size counters for receive and transmit, and the error counters for receive and transmit.

Rx and Tx Packets
RX and Tx Octets

Rx and Tx Unicast

Rx and Tx Multicast

Rx and Tx Broadcast

Rx and Tx Pause

Rx Error Counters:

The number of received and transmitted (good and bad) packets.

The number of received and transmitted (good and bad) bytes. Includes
FCS, but excludes framing bits.

The number of received and transmitted (good and bad) unicast packets.

The number of received and transmitted (good and bad) multicast
packets.

The number of received and transmitted (good and bad) broadcast
packets.

A count of the MAC Control frames received or transmitted on this port
that have an opcode indicating a PAUSE operation.

The number of received and transmitted (good and bad) packets split into categories based on their

respective frame sizes.

Rx Drops

RX CRC/Alignment
RX Undersize

Rx Oversize

The number of frames are dropped due to lack of receive buffers or egress
congestion.

The number of frames received with CRC or alignment errors
The number of short* frames received with valid CRC.

The number of long 2 frames received with valid CRC.
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Rx Error Counters: (Cont'd)

The number of received and transmitted (good and bad) packets split into categories based on their
respective frame sizes.

Rx Fragment : The number of short* frame received with invalid CRC.
Rx Jabber . The number of long? frames received with invalid CRC
Rx Filtered : The number of received frames filtered by the forwarding process.

tShort frames are frames that are smaller than 64 bytes.

2Long frames are frames that are longer than the configured maximum
frame length for this port.

Tx Error Counter:

Tx Drops . The number of frames dropped due to output buffer congestion.

Tx Late/Exc. Coll. . The number of frames dropped due to excessive or late collisions

Monitor > Security (Only applicable for Ether)

Monitor > Security > Access Management Statistics

P~RACX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summa ’ 5 gide - —
> c°nﬁgurryaﬁ°n Monitor > Security > Access Management Statistics Auto-refresh [ | Refresh || Clear

e Interface [ Received Packets [ Allowed Packets [ Discarded Packets
» System i1R13 : i 3

» Ports HEs - ; 0

¥ Security S : 0 0

= Access Management TELNED : ; 0
et SSH 0 0 0

» Switch
» Spanning Tree

= MAC Table

» VLANS

» Radio Performance
» Test&Diagnostics
» Maintenance

Monitor > Security > Access Management Statistics Menu Frame

Interface . The interface type through which the remote host can access the switch.

Received Packets : Number of received packets from the interface when access
management mode is enabled.

Allowed Packets : Number of allowed packets from the interface when access management
mode is enabled.

Discarded Packets . Number of discarded packets from the interface when access
management mode is enabled.

Auto-refresh . Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Refresh . Click to refresh the page immediately

Clear . Clear all statistics
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Monitor > Security > Switch > RMON > Statistics

& BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

] Monitor > Security > Switch > RMON > Statistics Autowbmh Rekesh

12
. Broad- | Multi-| CRC | Under- | Over- o el B B e B
» Systom o Port Orop | Octets | Phes | “ 0" | Tose | Ervors size | sige | T8 | Jabb. (Coll. gy | = | = | = | = -
»Pore [ [T TEE] 78 0 (1] 0 " ”I 2“4“': ’“1‘0 ’“!
2, ™ 1 e v LIAEX] ] 76 C 9 o L 4 ¢
i 2 Lina v 3 ) 3 0 0 0 ¢ 0 i 2 0 o ] :
J Mainnanca T4 188550 633 § 148 4 0 0 o 0 M 2% 72 M4 56 &1

» Rao Performance

» TesthDiagnostics

intenan

Monitor > Security > Switch > RMON > Statistics Menu Frame

This menu provides an overview of RMON Statistics entries. Each page shows up to 99 entries from
the Statistics table, default being 20, selected through the "entries per page" input field. When first
visited, the web page will show the first 20 entries from the beginning of the Statistics table. The first
displayed will be the one with the lowest ID found in the Statistics table.

The "Start from Control Index" allows the user to select the starting point in the Statistics table.
Clicking the Refresh button will update the displayed table starting from that or the next closest
Statistics table match. The >> will use the last entry of the currently displayed entry as a basis for the
next lookup. When the end is reached the text "No more entries" is shown in the displayed table. Use
the I<< button to start over

ID : Indicates the index of Statistics entry.

Port . The port ID which wants to be monitored.

Drop . The total number of events in which packets were dropped by the probe
due to lack of resources.

Octets . The total number of octets of data (including those in bad packets)
received on the network.

Pkts . The total number of packets (including bad packets, broadcast packets,
and multicast packets) received.

Broad-cast . The total number of good packets received that were directed to the
broadcast address.

Multi-cast . The total number of good packets received that were directed to a
multicast address.

CRC Errors : The total number of packets received that had a length (excluding
framing bits, but including FCS octets) of between 64 and 1518 octets.

Under-size . The total number of packets received that were less than 64 octets.

Over-size . The total number of packets received that were longer than 1518 octets.

Frag. : The number of frames which size is less than 64 octets received with
invalid CRC

Jabb. :  The number of frames which size is larger than 64 octets received with
invalid CRC

Coll. . The best estimate of the total number of collisions on this Ethernet
segment.
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64

65-127

128-255

256-512

513-1023

1024-1588

Auto-refresh

Refresh

I<<

>>

The total number of packets (including bad packets) received that were
64 octets in length

The total number of packets (including bad packets) received that were
between 65 to 127 octets in length.

The total number of packets (including bad packets) received that were
from 128 to 255 octets in length.

The total number of packets (including bad packets) received that were
from 256 to 511 octets in length.

The total number of packets (including bad packets) received that were
from 512 to 1023 octets in length

The total number of packets (including bad packets) received that were
from 1024 to 1588 octets in length.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Click to refresh the page immediately

Updates the table starting from the first entry in the Statistics table, i.e.
the entry with the lowest ID

Updates the table, starting with the entry after the last entry currently
displayed
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Monitor > Security > Switch > RMON > History

o3 BroadOne_GX400(

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

Monitor > Security > Switch > RMON > History Auto-cel seh Relrash Je >>

Sanrt from Controd Index 0 and Sample index with 20 enines per page
nen | e | s | ree [ ot [pvs [P [T e | [ i [Fow [ e ot ntasen
“"‘“‘_ 9964 0 0 0 0 ] ] L] ] 0|
1 2 1901 'J ] 0 0 ] 0 a 0 0 C 0|
1 3 3701 ¢ 0 0 0 0 0 0 0 .; ] D) o
1 4 5501 0 0 0 0 ] 0 0 0 0 ] 0 0|
= Matory 1 5 7301 7 0 0 0 0 0 0 0 0 0 0 0 ‘
> Spameing Troe 1 T e e e i o T 0]
» MAC Table 2 J o - : . - - - e |
2 1 9664 0 ] 0 0 0 0 0 b 0 ] 0 0|
PVLANS 2 2 1901 0 0 0 0 ] 9 0 0 7 0 0 0|
» Rao Performance 2 3 3701 2 0 0 o 0 2 0 0 0 0 0 0 1
» TestADuagnostics 2 4 5601 0 0 0 0 0 0 0 0 0 0 0 0|
* Maintenance 2 3 7301 [} 0 0 0 0 0 0 0 0 0 ¢ 0|
2 3 a1 0 0 0 0 0 0 ] 0 0 0 0 0|
2 1 10801 0 0 0 0 0 0 0 0 0 0 0 0|
k] 1 3964 0 2690538 1060 278 244 ] 0 0 0 0 0|
3 2 1901 0 oa41En 124 8 60 0 0 (i 0 0 0 0|
1 3 3701 0 99338 265 3% 230 ] 0 0 0 ] D) 0|
3 4 5501 0 255 65 5 50 0 0 0 0 0 ¢ 0|
3 5 7301 o 323% 64 4 60 a 0 0 0 0 0|
3 5 9401 0 32583 65 5 50 [ ] 2 D) ] 0 1 |

Monitor > Security > Switch > RMON > History Menu Frame

This menu provides an overview of RMON History entries. Each page shows up to 99 entries from the
Statistics table, default being 20, selected through the "entries per page" input field. When first visited,
the web page will show the first 20 entries from the beginning of the Statistics table. The first displayed
will be the one with the lowest ID found in the Statistics table.

The "Start from Control Index" allows the user to select the starting point in the Statistics table.
Clicking the Refresh button will update the displayed table starting from that or the next closest
Statistics table match. The >> will use the last entry of the currently displayed entry as a basis for the
next lookup. When the end is reached the text "No more entries" is shown in the displayed table. Use
the I<< button to start over

History Index : Indicates the index of History control entry.
Sample Index . Indicates the index of the data entry associated with the control entry
Sample Start . The total number of events in which packets were dropped by the probe

due to lack of resources.

Drop . The total number of events in which packets were dropped by the probe
due to lack of resources

Octets . The total number of octets of data (including those in bad packets)
received on the network.

Pkts . The total number of packets (including bad packets, broadcast packets,
and multicast packets) received.

Broadcast e total number of good packets received that were directed to the
broadcast address

Multicast :  The total number of good packets received that were directed to a
multicast address

CRCError . The total number of packets received that had a length (excluding
framing bits, but including FCS octets) of between 64 and 1518 octets

Undersize . The total number of packets received that were less than 64 octets.
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Oversize

Frag.

Jabb.

Coll.

Utilization

Auto-refresh

Refresh

<<

>>

The total number of packets received that were longer than 1518 octets.

The number of frames which size is less than 64 octets received with
invalid CRC.

The number of frames which size is larger than 64 octets received with
invalid CRC.

The best estimate of the total number of collisions on this Ethernet
segment.

The best estimate of the mean physical layer network utilization on this
interface during this sampling interval, in hundredths of a percent.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Click to refresh the page immediately

Updates the table starting from the first entry in the History table, i.e., the
entry with the lowest History Index and Sample Index

Updates the table, starting with the entry after the last entry currently
displayed

Monitor > Spanning Tree (Only applicable for Ether)

Monitor > Spanning Tree > Bridge Status

pP-BeX H @ BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet

[Nakahara001#:]
= Summa 2 . .
» CQnﬁgurryation Monitor > Spanning Tree > Bridge Status Auto-refresh [[] | Refresh
st STP Bridge Status
» System Bridge Instance CIST
» Ports Bridge ID 80:00-5C:9A:D8:36:AF:1B
Securf Root ID 80:00-5C:9A:D8:36:AF:1B
i ty Root Cost 0
= Access Management
Statistics Root Port 0
+ Switch Regional Root 80:00-5C:9A:D8:36:AF:1B
+ RMON Internal Root Cost 0
= Statistics Topology Flag Steady
= History Topology Change Count 0
w Spanning Tree Topology Change Last -
= Bridge Status
= Port Status CIST Ports & Aggregations State
= Port Statistics
= MAC Table Port [ PortID | Role | State | Path Cost | Edge | Point2Point | Uptime |
» VLANS No ports or aggregations active
» Radio Performance
» Test&Diagnostics
» Maintenance

Monitor > Spanning Tree > Bridge Status Menu Frame

This menu provides detailed information on a single STP bridge instance, along with port state for all

active ports associated.
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STP Bridge Status:

Bridge Instance
Bridge ID

Rout ID

Root Cost

Root Port

Regional Root

Internal Root Cost

Topology Flag

Topology Change
Count

Topology Change
Last

The Bridge instance - CIST, MST1, ...

The Bridge ID of this Bridge instance.

The Bridge ID of the currently elected root bridge
The switch port currently assigned the root port role.

Root Path Cost. For the Root Bridge this is zero. For all other Bridges, it is
the sum of the Port Path Costs on the least cost path to the Root Bridge.

The Bridge ID of the currently elected regional root bridge, inside the MSTP
region of this bridge. (For the CIST instance only). MSTP:not available.

The Regional Root Path Cost. For the Regional Root Bridge this is zero. For
all other CIST instances in the same MSTP region, it is the sum of the
Internal Port Path Costs on the least cost path to the Internal Root Bridge.
(For the CIST instance only). MSTP:not available.

The current state of the Topology Change Flag of this Bridge instance.

The number of times where the topology change flag has been set (during a
one-second interval).

The time passed since the Topology Flag was last set.

CIST Port & Aggregation State

Port
Port ID

Role

State

Path Cost

Edge

Point-to-Point

Uptime

Auto-refresh

Refresh

The switch port number of the logical STP port.

The port id as used by the STP protocol. This is the priority part and the
logical port index of the bridge port

The current STP port role. The port role can be one of the following
values: Alternate Port, Backup Port, Root Port and Designated Port.

The current STP port state. The port state can be one of the following
values: Discarding, Learning, Forwarding.

The current STP port path cost. This will either be a value computed from
the Auto setting, or any explicitly configured value.

The current STP port (operational) Edge Flag. An Edge Port is a switch
port to which no Bridges are attached. The flag may be automatically
computed or explicitly configured. Each Edge Port transits directly to the
Forwarding Port State, since there is no possibility of it participating in a
loop.

The current STP port point-to-point flag. A point-to-point port connects to
a non-shared LAN media. The flag may be automatically computed or
explicitly configured. The point-to-point properties of a port affect how
fast it can transit to STP state.

The time since the bridge port was last initialized

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Click to refresh the page immediately
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Monitor > Spanning Tree > Port Status

P~BLX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] W

= Summary = ; —
» Configuration Monitor > Spanning Tree > Port Status Auto-refresh [ | Refresh

sl Port | CIST Role | CIST State | Uptime
» System Radio Non-STP Forwarding -
» Ports - Line Non-STP Forward!ng -
» Secuiity Maintenance Non-STP Forwarding -
v Spanning Tree
= Bridge Status
= Port Status
= Port Statistics
= MAC Table

» VLANS

» Radio Performance
» Test&Diagnostics
» Maintenance

Monitor > Spanning Tree > Port Status Menu Frame

This menu displays the STP CIST port status for physical ports of the switch.
Port . The switch port name of the logical STP port

CIST Role . The current STP port role of the CIST port. The port role can be one of
the following values: Alternate Port, Backup Port, Root Port,
Designated Port and Disabled.

CIST State . The current STP port state of the CIST port. The port state can be one of
the following values: Discarding, Learning and Forwarding.

Uptime . The time since the bridge port was last initialized.

Auto-refresh Check this box to refresh the page automatically. Automatic refresh

occurs every 3 seconds

Refresh Click to refresh the page immediately
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Monitor > Spanning Tree > Port Statistics

PL~-BCX H @ BroadOne_GX4000

= Summary

~ Monitor

» Configuration Monitor > Spanning Tree > Port Statistics Auto-refresh [C] | Refresh || Clear

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] &

= Alarm Port
» System

Transmitted Received Discarded
MSTP | RSTP | STP | TCN [ MSTP | RSTP [ STP | TCN | Unknown | lllegal |

» Poris No ports enabled

» Security

¥ Spanning Tree
= Bridge Status
= Port Status

= Port Statistics
= MAC Table

» VLANS

» Radio Performance
» Test&Diagnostics
» Maintenance

Monitor > Spanning Tree > Port Statistics Menu Frame

This menu displays the STP port statistics counters of bridge ports in the switch

Port
MSTP

RSTP

STP

TCN

Discarded Unknown

Discarded lllegal

Auto-refresh

Refresh

Clear

The switch port number of the logical STP port.

The number of MSTP Configuration BPDU's received/transmitted on the
port MSTP:not available.

The number of RSTP Configuration BPDU's received/transmitted on the
port

The number of legacy STP Configuration BPDU's received/transmitted on
the port.

The number of (legacy) Topology Change Notification BPDU's
received/transmitted on the port.

The number of unknown Spanning Tree BPDU's received (and discarded)
on the port.

The number of illegal Spanning Tree BPDU's received (and discarded) on
the port.

Check this box to refresh the page automatically. Automatic refresh occurs
every 3 seconds

Click to refresh the page immediately

Click to reset the counters
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Monitor > MAC Table (Only applicable for Ether)

P~RBCX H & BroadOne_GX4000

-

Fujitsu BroadOne GX4000 Series - Ethernet o @
[Nakahara001#:] L

.S
)c:rﬁ";zrryaﬁon Monitor > MAC Table Auto-refresh [ [ Refresh ][ Clear ] [ Je< H >> }

v Monitor
= Alarm Start from VLAN 1 and MAC address 00-00-00-00-00-00 with 20 entries per page.
» System
» Ports Port Members
» Security Type [ VLAN | MAC Address [CPU[Maintenance|Line[Radio
» Spanning Tree Dynamic 1  4C-E6-76-55-37-E& A
» MAC Table iz
» VLANS tatic 1
» Radio Performance Static 1 FF-FF-FF-FF-FF-FF
» Test&Diagnostics
» Maintenance

SC-9A-D8-36-AF-1B ,

Monitor > MAC Table Menu Frame

Entries in the MAC Table are shown on this page. The MAC Table contains up to 8192 entries, and is
sorted first by VLAN 1D, then by MAC address

Navigating the MAC Table

Each page shows up to 999 entries from the MAC table, default being 20, selected through the "entries
per page" input field. When first visited, the web page will show the first 20 entries from the beginning
of the MAC Table. The first displayed will be the one with the lowest VLAN ID and the lowest MAC
address found in the MAC Table.

The "Start from MAC address" and "VLAN" input fields allow the user to select the starting point in the
MAC Table. Clicking the Refresh button will update the displayed table starting from that or the closest
next MAC Table match. In addition, the two input fields will - upon a Refresh button click - assume the
value of the first displayed entry, allowing for continuous refresh with the same start address.

The >> will use the last entry of the currently displayed VLAN/MAC address pairs as a basis for the
next lookup. When the end is reached the text "No more entries" is shown in the displayed table. Use
the I<< button to start over.

Switch (stack only) . The switch port number of the logical STP port.

Type . The stack unit where the entry is learned

VLAN : The VLAN ID of the entry.

MAC Address . The MAC address of the entry

Port Member . The ports that are members of the entry

Auto-refresh . Automatic refresh occurs every 3 seconds

Refresh . Refreshes the displayed table starting from the "Start from MAC address"
and "VLAN" input fields

Clear . Flushes all dynamic entries

I<< . Updates the table starting from the first entry in the MAC Table, i.e. the
entry with the lowest VLAN ID and MAC address

>> . Updates the table, starting with the entry after the last entry currently
displayed.
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Monitor > VLANs (Only applicable for Ether)

Monitor > VLANs > VLAN Membership

2 P~BAEX H @ BroadOne_GX4000 LJ

Fujitsu BroadOne GX4000 Series - Ethernet G ®
[Nakahara001#:] Sl

= Summary i .
» Configuration Monitor > VLANs > VLAN Membership Combined B Auto-refresh || | Refresh
~ Monitor R

= Alarm Start from VLAN 1 with 20 entries per page. >

» System

» Ports Port Members

» Security VLAN ID [Maintenance[Line[Radio

» Spanning Tree 1 ] ¥ &

= MAC Table 2 v il |

MEANS.
= VLAN Membership
= VLAN Port

» Radio Performance

» Test&Diagnostics
» Maintenance

Monitor > VLANs > VLAN Membership Menu Frame

This menu provides an overview of membership status of VLAN users.

VLAN User . VLAN User module uses services of the VLAN management functionality
to configure VLAN memberships and VLAN port configurations such as
PVID and UVID. Currently we support the following VLAN user types:

Web/SNMP: These are referred to as static.

MSTP : The 802.1s Multiple Spanning Tree protocol (MSTP) uses
VLANS to create multiple spanning trees in a network, which significantly
improves network resource utilization while maintaining a loop-free
environment. MSTP:not available.

Port Membership . Arow of check boxes for each port is displayed for each VLAN ID.
If a port is included in a VLAN, an image ¥ will be displayed.
If a portis included in a Forbidden port list, an image * will be displayed.
If a port is included in a Forbidden port list and dynamic VLAN user
register VLAN on same Forbidden port, then conflict port will be
displayed as .

VLAN Membership . The VLAN Membership Status Page shall show the current VLAN port
members for all VLANs configured by a selected VLAN User (selection
shall be allowed by a Combo Box). When ALL VLAN Users are selected,
it shall show this information for all the VLAN Users, and this is by
default. VLAN membership allows the frames classified to the VLAN ID to
be forwarded on the respective VLAN member ports.

Button . Select VLAN Users from Static, MSTP and Combined.
MSTP:not available.

Auto-refresh . Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Refresh . Click to refresh the page immediately
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Navigating the VLAN Monitor page

Each page shows up to 99 entries from the VLAN table, default being 20, selected through the "entries
per page" input field. When first visited, the web page will show the first 20 entries from the beginning
of the VLAN Table. The first displayed will be the one with the lowest VLAN ID found in the VLAN

Table.

The "VLAN" input fields allow the user to select the starting point in the VLAN Table. Clicking the
Refresh button will update the displayed table starting from that or the closest next VLAN Table
match. The >> will use the last entry of the currently displayed VLAN entry as a basis for the next
lookup. When the end is reached the text "No more entries" is shown in the displayed table. Use the

I<< button to start over.

Monitor > VLANs > VLAN Port

p~BeX H @ BroadOne_GX4000

-

Fujitsu BroadOne GX4000 Series - Ethernet G e

= Summary

v Monitor

[Nakahara001#:]

= Alarm Port
» System

» Poris Radio
» Security

» Configuration Monitor > VLANs > VLAN Port Staic  [v]Auto-refresh [] | Refresh
Port Ingress Frame ~

PVID Type Filtering Type Tx Tag | UVID | Conflicts

1 UnAware Disabled All  Untag_this 1 No

Line 1 UnAware Disabled All  Untag_this 1 No

Maintenance 1 UnAware Disabled All _Untag_this 1 No

» Spanning Tree
= MAC Table

v VLANs
= VLAN Membership
= VLAN Port
» Radio Performance
» Test&Diagnostics
» Maintenance

Monitor > VLANs > VLAN Port Menu Frame

VLAN User

Port
PVID

Port Type

Ingress Filtering

VLAN User module uses services of the VLAN management functionality
to configure VLAN memberships and VLAN port configurations such as
PVID and UVID. Currently we support the following VLAN user types:
Web/SNMP : These are referred to as static.

MSTP: The 802.1s Multiple Spanning Tree protocol (MSTP) uses VLANs
to create multiple spanning trees in a network, which significantly
improves network resource utilization while maintaining a loop-free
environment. MSTP:not available.

The port name in the same row.

Shows the VLAN identifier for that port. The allowed values are 1 through
4095. The default value is 1.

Shows the Port Type. Port type can be any of Unaware, C-port, S-port,
Custom S-port. If Port Type is Unaware, all frames are classified to the
Port VLAN ID and tags are not removed. C-port is Customer Port. S-port
is Service port. Custom S-port is S-port with Custom TPID.

Shows the ingress filtering on a port. This parameter affects VLAN
ingress processing. If ingress filtering is enabled and the ingress port is
not a member of the classified VLAN, the frame is discarded.
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Frame Type

Tx Tag
uviD

Conflicts

Button

Auto-refresh

Refresh

Shows whether the port accepts all frames or only tagged frames. This
parameter affects VLAN ingress processing. If the port only accepts
tagged frames, untagged frames received on that port are discarded.

Shows egress filtering frame status whether tagged or untagged.

Shows UVID (untagged VLAN ID). Port's UVID determines the packet's
behaviour at the egress side

Shows status of Conflicts whether exists or not. When a Volatile VLAN
User requests to set VLAN membership or VLAN port configuration, the
following conflicts can occur:

Functional Conflicts between features.
Conflicts due to hardware limitation.
Direct conflict between user modules.

Select VLAN Users from Static, MSTP and Combined.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds

Click to refresh the page immediately

Monitor > Radio Performance

Monitor > Radio Performance > Current

* Summary
» Conhguration
* Manitor

Monitor > Radio Performance > Curremt

Fujitsu BroadOne GX4000 Series - Ethernet
[Ether70G-3)

- Aare [ Time

» Sywom M207- 2311 8

narce

o1 Doy
* TestADiagnottics
» Maintenance

TxLevel (d8ni) | Rx Level (dBm) | Radie Link Quality
& 2 &

Monitor > Radio Parameter > Current Menu Frame

Radio Performance > Current:

Time
Tx Level (dBm)
Rx Level (dBm)

Radio Link
Quality

Auto-refresh

Refresh

The time that measured performance data.
The signal level of radio transmitting.

The signal level of radio receiving.

Display radio link quality

Green: Radio link quality high
Yellow: Radio link quality middle Red: Radio link quality low
Grey: Radio link quality is Loss of Frame

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds.

Click to refresh the page
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Monitor > Radio Performance > 15 Minutes

* Summary
¥ Commiguration

Fujitsu BroadOne GX4000 Series - Ethernet
[Ether70G-3)

Monitor > Radio Performances > 15 Minutes po-rshiod Retuat
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Monitor > Radio Parameter > 15 Minutes Menu Frame

Monitor > Radio Performance > 15 Minutes:

This page provides historical radio performance data measured with 15 minutes window. As
maximum, latest 72 hours of historical performance data can be seen.

Time

Tx Level (dBm) Min.

TX Level (dBm) Max.

Rx Level (dBm) Min.

Rx Level (dBm) Max.

Block Errors

Error Seconds

Block Error Ratio

Auto-refresh

Refresh

The starting time of the 15 minutes window. The minute is fixed with
0, 15 30 and 45 on every hour.

Indicates the minimum signal level of radio transmitting in 15 minutes
window.

Indicates the maximum signal level of radio transmitting in 15
minutes window.

Indicates the minimum signal level of radio receiving in 15 minutes
window.

Indicates the maximum signal level of radio receiving in 15 minutes
window.

Indicates the number of block error in 15 minutes window

Indicates the number of the second that have block error in 15
minutes window.

Indicates the ratio of the number of block error in the total number of
block in 15 minutes window.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds.

Click to refresh the page
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Monitor > Radio Performance > 1 Day

- (= [ B ]

G‘ ‘:—) http://192.168.0.10 PL~BCEX H & BroadOne_GX4000 X l ‘

Fujitsu BroadOne GX4000 Series - Ethernt
[Nakahara001#:]

= Summary
» Configuration
v Monitor

Monitor > Radio Performance > 1 Day

Auto-refresh [ | Refresh

5 Tx Level Rx Level
» Ports Min. [ Max. [ Min. [ Max.
» Security No entries

» Spanning Tree

= MAC Table

» VLANS

¥ Radio Performance
= Current
= 15 Minutes

= 1 Day
> Test&Diagnostics
» Maintenance

Monitor > Radio Parameter > 1 Day Menu Frame

Monitor > Radio Performance > 1 Day:

This page provides historical radio performance data measured with 1 day window. As maximum,
latest 2 days of historical performance data can be seen.

Time : The starting time of the 1 day window. The time is fixed with 0:00 in
every day.

Tx Level (dBm) Min. Indicates the minimum signal level of radio transmitting in 1 day

window.

TX Level (dBm) Max.

Rx Level (dBm) Min.

Rx Level (dBm) Max.

Block Errors

Error Seconds

Block Error Ratio

Auto-refresh

Refresh

Indicates the maximum signal level of radio transmitting in 1 day
window

Indicates the minimum signal level of radio receiving in 1 day
window.

Indicates the maximum signal level of radio receiving in 1 day
window.

Indicates the number of block error in 1 day window

Indicates the number of the second that have block error in 1 day
window.

Indicates the ratio of the number of block error on the total number of
block in 1 day window.

Check this box to refresh the page automatically. Automatic refresh
occurs every 3 seconds.

Click to refresh the page
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Test & Diagnostics

Test & Diagnostics > Control
= [ [ e
P~-BeX H @ BroadOne_GX4000 LJ i o3

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] L

= Summary

» Configuration Test & Diagnostics > Control Refresh
» Monitor Item Current | Control | Timer

v Test&Diagnostics Radio LoopBack - Operate elea 30sec [+]

= Controf
«Ping Tx-OFF Tx-OFF erats Release
» Maintenance Line LoopBack - | Operate | leas 30sec [v]

Test & Diagnostics > Control Menu Frame

This menu allows you to control of test and diagnosis

Iltem . Radio LoopBack: Operation of Loopback for Radio side.
Tx-OFF: Operation of shut-off for radio transmitting.
Line LoopBack: Operation of Loopback for Line side.

Current . Indicates current condition. The displayed conditions are;
Operate: Operation is active.
-: Operation is inactive.

Control . Operate: Click to operate the item.
Release: Click to release the item

Timer . Set the remaining time. The Radio LoopBack and the Line LoopBack
is released automatically if the time is up.
The allowed range is
10 seconds
20 seconds
30 seconds
1 minute
10 minutes
30 minutes
1 hour
3 hours
12 hours
24 hours
None (Non auto-release)

The default value is 30 seconds.

Refresh . Click to refresh the page
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Test & Diagnostics > Ping

P~BeX H & BroadOne_GX4000

-

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

& 2

= Summary
» Configuration
» Monitor

Test&Diagnostics > Ping

+ Test&Diagnostics IP Address  0.0.0.0
= Control Ping Length 56
= Ping Ping Count 5

» Maintenance

Ping Interval 1

| Start

Test & Diagnostics > Ping Menu Frame

This menu allows you to issue ICMP PING packets to troubleshoot IP connectivity issues.

After you press , ICMP packets are transmitted, and the sequence number and round trip time are
displayed upon reception of a reply. The amount of data received inside of an IP packet of type
ICMP ECHO_REPLY will always be 8 bytes more than the requested data space(the ICMP
header). The page refreshes automatically until responses to all packets are received, or until a
timeout occurs.

PING server 10.10.132.20, 56 bytes of data.

64 bytes from 10.10.132.20:
64 bytes from 10.10.132.20:
64 bytes from 10.10.132.20:
64 bytes from 10.10.132.20:
64 bytes from 10.10.132.20:

icmp_seq=0, time=0ms
icmp_seq=1, time=0ms
icmp_seq=2, time=0ms
icmp_seq=3, time=0ms

icmp_seq=4, time=0ms

Sent 5 packets, received 5 OK, 0 bad

You can configure the following properties of the issued ICMP packets

IP Address
Ping Length

Ping Count

Ping Interval

Start
New Ping

The destination IP Address

The payload size of the ICMP packet. Values range from 2 bytes to
1452 bytes.

The count of the ICMP packet. Values range from 1 time to 60 times.

The interval of the ICMP packet. Values range from 1 second to 30
seconds

Click to start transmitting ICMP packets
Click to re-start diagnostics with PING
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Maintenance

Maintenance > Restart Devices

P~BeX H & BroadOne_GX4000

L]

Fujitsu BroadOne GX4000 Series - Ethernet o @
[Nakahara001#:] e

= Summa
> cOnﬁgurryaﬂon Maintenance > Restart Device
» Monitor
» Test&Diagnostics
¥ Maintenance
= Restart Device
= Factory Defaults
» Software
» FPGA
» Configuration
» Data

Are you sure you want to perform a Restart?

Maintenance > Restart Devices Menu Frame

You can restart the switch on this page. After restart, the switch will boot normally
Yes . Click to restart device

No . Click to return to the Port State page without restarting

ax 7 | @ http://192.168.0.10

P~BLX H & BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Ports -
» Security System restart in progress
w Spanning Tree
= Bridge Settings
= CIST Ports
= SyncE
= MAC Table
» VLAN Translation
» VLANS
» Monitor
» Test&Diagnostics
v Maintenance
= Restart Device
= Factory Defaults
» Software
» FPGA
» Configuration
» Data

The system is now restarting.

When click Yes, Restarting display will appear.
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Maintenance > Factory Defaults

PL~-BeX H @ BroadOne_GX4000

-

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] LA

» gl;:‘f’i‘;?]rryaﬁon Maintenance > Factory Defaults
» Monitor
» Test&Diagnostics
v Maintenance
= Restart Device
= Factory Defaults
» Sofiware
» FPGA
» Configuration

Are you sure you want to reset the configuration

to
Factory Defaults?

» Data

Maintenance > Factory Defaults Menu Frame

You can reset the configuration of the switch on this page. Only the |IP configuration is retained.
The new configuration is available immediately, which means that no restart is necessary

Yes . Click to reset the configuration to Factory Defaults

No . Click to return to the Port State page without resetting the configuration

Note: Restoring factory default can also be performed by making a physical
loopback between port 1 and port 2 within the first minute from switch reboot. In
the first minute after boot, 'loopback' packets will be transmitted at port 1. If a
'loopback’ packet is received at port 2 the switch will do a restore to default
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Maintenance > Software

Maintenance > Software > Upload

/> BroadOne_GX4000 - Windows Internet Explorer

Go- e 3] [x) [P o G

7.7 Favorites

(€ BroadOne_GX4000

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

= Summa
> COnﬁgur,Yaﬁon Maintenance > Software > Upload

» Monitor ‘
» Test&Diagnostics ‘ | Browse.. ]| Upload

¥ Maintenance
= Restart Device
= Factory Defaults
v Software
= Upload
= [mage Select
» FPGA
» Configuration
» Data

Maintenance > Software > Upload Menu Frame

This page is used to update the software to the latest version.

The versions of software images are displayed, and the alert message to confirm it is displayed.
Up-loading begins after clicking OK.

The up-loaded image is stored on the STBY side, and after a few minutes, up-loading is
completed.

NOTICE: Do not restart or power off the device at this time or the device may fail to function
afterwards.

Browse . Click to the location of software image

Upload . Click to upload the software image

BroadOne GX4000 Manual (R3.0) issue 1.02 5-67



Web-based LT FUﬁTSU

Fujitsu and Fujitsu Customer Use Only

Maintenance > Software > Image Select
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-

Fujitsu BroadOne GX4000 Series - Ethernet G @
[Nakahara001#:] L

= Summa .
> c°nﬁgul|.ryati°n Maintenance > Software > Image Select
» Monitor
» Test&Diagnostics s Ac;;mﬂes
il Version V01L01C06-01a
= Factory Defaults
v Software STBY Image
= Upload Image  managed.bk
« Jmage Select Version V01L51C06-01a

» FPGA
» Configuration [ Activate STBY Image & Reset ] [ Cancel

» Data

Maintenance > Software > Image Select Menu Frame

This page provides information about the ACT software image and the STBY software image in
the device, and allows you to select to the STBY software image.
Reset operates when switching.

The web page displays two tables with information about the ACT software image and the STBY
software image.

Note: 1.In case the ACT image is alternate image, only the "ACT Image" table is shown. In this
case, the "Activate STBY Image & Reset" button is also disabled.

Image . The flash index name of the software image. The name of primary
image is managed, the alternate image is named managed.bk.

Version . The version of the software image, and the date where the software
was produced.

Activate STBY . Activate STBY Image & Reset: Click to use the STBY image. This

Image & Reset button may be disabled depending on system state.

Cancel . Cancel activating the STBY image. Navigates away from this page.
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Maintenance > FPGA

Maintenance > FPGA > Upload

o~ BroadOne_GX4000 - Windows Internet Explorer

Go- e

(€ BroadOne_GX4000

7.0 Favorites

Fujitsu BroadOne GX4000 Series - Ethernet
[Nakahara001#:]

=
> cz:%au?aﬁon Maintenance > FPGA > Upload

» Monitor
» Test&Diagnostics [ ‘ Upload ]
v Maintenance | Browse.. ] 1P :
= Restart Device
= Factory Defaults
¥ Software
= Upload

= [mage Select
¥ FPGA

= Upload

= [mage Select
» Configuration
» Data

Maintenance > FPGA > Upload Menu Frame

This page is used to update the FPGA data to the latest version.

The versions of FPGA data images is displayed, and the alert message to confirm it is displayed.
Up-loading begins after clicking OK.

The up-loaded image is stored on the STBY side, and after a few minutes, up-loading is
completed.

NOTICE: Do not restart or power off the device at this time or the device may fail to function
afterwards.

Browse . Click to the location of FPGA image
Upload . Click to upload the FPGA image
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Maintenance > FPGA > Image Select
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= S
» c';':f!,g:?aﬂon Maintenance > FPGA > Image Select

» Monitor 1
» Test&Diagnostics ACT ge
Image  managed

v Maintenance s
« Restart Device Version V00LDO5C00

= Factory Defaults

» Soﬂw[ayre STBY Image

v FPGA Image  managed.bk
= Upl Version V0OL05CO0

» Configuration [ Activate STBY Image & Reset J [ Cancel ]

» Data

Maintenance > FPGA > Image Select Menu Frame

This page provides information about the ACT FPGA data image and the STBY FPGA data image
in the device, and allows you to select to the STBY FPGA data image. Reset operates when
switching. The web page displays two tables with information about the ACT FPGA data image
and the STBY FPGA data image.

Note: 1.In case the ACT image is alternate image, only the "ACT Image" table is shown. In this
case, the "Activate STBY Image & Reset" button is also disabled.

Image . The flash index name of the FPGA data image. The name of primary
image is managed, the alternate image is named managed.bk.

Version . The version of the FPGA data image.

Activate STBY . Activate STBY Image & Reset: Click to use the STBY image. This

Image & Reset button may be disabled depending on system state.

Cancel . Cancel activating the STBY image. Navigates away from this page.
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Maintenance > Configuration

Maintenance > Configuration > Save

P~RBCX ]l & BroadOne_GX4000

-

Fujitsu BroadOne GX4000 Series - Ethernt
[Nakahara001#:]

= Summa ) )
> cgnﬁgu?;ﬁon Maintenance > Configuration > Save

» Monitor -
» Test&Diagnostics Save Configuration

v Maintenance
= Restart Device
= Factory Defaults
» Sofiware
» FPGA

v Configuration
= Save

= Upload
» Data

Maintenance > Configuration > Save Menu Frame

You can savel/view the device configuration. The configuration file is XML format.
When the Save Configuration button is clicked, the file of the name of
config_yyyymmdd_hhmiss.xml is saved.

The example of the file name) config_20120624 160745_.xml
yyyy: year

mm: month

dd: day

hh: hour

mi: minute

ss: second

NOTICE: Do not edit the XML file. The up-loading of the edited XML file is unsupported.
The device might malfunction even if up-loading is normally completed

Save Configuration . Click to save the configuration file
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Main

o~ BroadOne_GX4000 - Windows Internet Explorer

&~ & ¥ (%] [x] @ n |[2]-
| ¢ Favorites g3 @ Suogested Sites > @] Free Hotmail @] Vet sallsty v
(& BroadOne_GX4000 M v B) 0 Y @ v Pagev Safety v Tooksv @~ & B

tenance > Configuration > Upload

Pr— —

Fujitsu BroadOne GXEOOO Series - Ethernet G’ &

= Summa
» COnﬁgu?aﬂon Maintenance > Configuration > Upload

» Monitor :
» Test&Diagnostics ‘ ,1
v Maintenance
= Restart Device
= Factory Defaults
» Software
» FPGA
w Configuration
= Save
= Upload
» Data

Done (g €D Internet fa v Hi00% ~

Mamtenance > LOH'IgUI’&EIOﬂ > Uploaa Menu Frame

You can upload the device configuration. The configuration file is XML format. When the Upload
button is clicked, the file of the configuration is up-loaded.

The example of the file name) config_20120624_160745_.xml

yyyy: year

mm: month

dd: day

hh: hour

mi: minute

ss: second

NOTICE: Do not edit the XML file. The up-loading of the edited XML file is unsupported.
The device might malfunction even if up-loading is normally completed

Browse . Click to save the configuration file

Upload . Click to upload the configuration file
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Maintenance > Data

Maintenance > Data > CSV Download

- [EEREERTS)

P~-BeX H & BroadOne_GX4000 l_J

Fujitsu BroadOne GX4000 Series - Ethernet o ®
[Nakahara001#:] 2 s

» gz:'%f,',yaﬁon Maintenance > Data > CSV DownLoad
: "::s';l&ul’)l;agnostics Dovmipad FILE Data
+ Maintenance Syslog(Current) [~]

= Restart Device

= Factory Defaults Save CSV Data

» Sofiware

» FPGA

» Configuration
wibata ...
= CSV Downloac

Maintenance > Data > CSV Download Menu Frame

You can download information selected with Download FILE Data. The data file is CSV file format.
When the Save CSV Data button is clicked, the file of the name of kkkk_yyyymmdd_hhmiss.csv is
saved.

Download File Data . Syslog: Data of Syslog is downloaded. (Data including the old
information is downloaded when there is an old information.)
Radio Performance Data (15min): Radio Performance Data of 15min
is downloaded.
Radio Performance Data (1Day): Radio Performance Data of 1Day is
downloaded.

The example of the file name) syslog_20120624_160745_.xml
kkkk: syslog/15minpm/ldaypm

yyyy: year

mm: month

dd: day

hh: hour

mi: minute

ss: second

Save CSV Data Click to start CSV download
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5.6 SNMP Agent Function

BroadOne GX4000 Impulse radio equipment has the SNMP agent function
in addition to Web-based local terminal (WebLT) function. SNMP agent
function supports SNMP v1 and SNMP v2c.

Table 5.3 shows the MIB Il support list.

Table 5.3 MIB 1l Support List

No. Group Remarks

1 System (1.3.6.1.2.1))

2 Interfaces (1.3.6.1.2.1.2)

3 Ip (1.3.6.1.2.1.4) ipForwarding is NOT supported.

4 Icmp (1.3.6.1.2.1.6)

5 |Tcp(1.3.6.1.2.1.6)

6 Udp (1.3.6.1.2.1.7)

7 | Snmp (1.3.6.1.2.1.11)

8 Only three groups are supported;
rmonEthernetStatistics grou

Rmon (1.3.6.1.2.1.16) rmonHistoryControl grogp P

rmonEthernetHistory group

9 ifMIB (1.3.6.1.2.1.31) Only ifTable group is supported
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Appendix-A Notice for Licensing

This system contains source code from the following Open-Source components. Some code has been altered
to work with the embodying system.

- Dropbear: SSH Server

- MD5: MD5 hash implementation

- MooTools: JavaScript Framework

- NET-SNMP: SNMP Agent

- NET-SNMP RMON: NET-SNMP RMON utilities

- NTP - Network Time Protocol: NTP Protocol

- OpenSSL: Toolkit implementing SSL v2/v3 and TLS protocols
- avltree: Self-balancing binary search tree

- eCos RTOS: Real-time OS for embedded applications

Name : Dropbear
Description : SSH Server
License type : MIT, BSD, OpenSSL

Dropbear contains a number of components from different sources, hence there are a few licenses and authors
involved. All licenses are fairly non-restrictive.

The majority of code is written by Matt Johnston, under the license below.

Portions of the client-mode work are (c) 2004 Mihnea Stoenescu, under the same license:
Copyright (c) 2002-2006 Matt Johnston Portions copyright (c) 2004 Mihnea Stoenescu

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS I1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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sshpty.c is taken from OpenSSH 3.5p1,
Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland All rights reserved

"As far as | am concerned, the code | have written for this software can be used freely for any purpose. Any
derived versions of this software must be clearly marked as such, and if the derived work is incompatible with
the protocol description in the RFC file, it must be called by a name other than "ssh" or "Secure Shell". "

loginrec.c
loginrec.h
atomicio.h
atomicio.c
and strlcat() (included in util.c) are from OpenSSH 3.6.1p2, and are licensed under the 2 point BSD license.

loginrec is written primarily by Andre Lucas, atomicio.c by Theo de Raadt.
stricat() is (c) Todd C. Miller

Import code in keyimport.c is modified from PuTTY's import.c, licensed as follows:
PUTTY is copyright 1997-2003 Simon Tatham.

Portions copyright Robert de Bath, Joris van Rantwijk, Delian Delchev, Andreas Schultz, Jeroen Massar, Wez
Furlong, Nicolas Barry, Justin Bradford, and CORE SDI S.A.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Name - MD5

Description : MD5 hash implementation

License type : BSD

Copyright (c) 2003-2005, Jouni Malinen <j@w1.fi>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public
License version 2 as published by the Free Software Foundation.

Alternatively, this software may be distributed under the terms of BSD license.
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Name : MooTools

Description : JavaScript Framework

License type : MIT

The MIT License

Copyright (c) 2006-2009 Valerio Proietti, <http://mad4milk.net/>

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Name : NET-SNMP
Description : SNMP Agent
License type : NET-SNMP (BSD-Style)

Various copyrights apply to this package, listed in 5 separate parts below. Please make sure that you read all
the parts. Up until 2001, the project was based at UC Davis, and the first part covers all code written during this
time. From 2001 onwards, the project has been based at SourceForge, and Networks Associates Technology,
Inc hold the copyright on behalf of the wider Net-SNMP community, covering all derivative work done since
then. An additional copyright section has been added as Part 3 below also under a BSD license for the work
contributed by Cambridge Broadband Ltd. to the project since 2001. An additional copyright section has been
added as Part 4 below also under a BSD license for the work contributed by Sun Microsystems, Inc. to the
project since 2003.

Code has been contributed to this project by many people over the years it has been in development, and a full
list of contributors can be found in the README file under the THANKS section.

---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1989, 1991, 1992 by Carnegie Mellon University
Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California, All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright notice appears in all copies and that both that copyright
notice and this permission notice appear in supporting documentation, and that the name of CMU and The
Regents of the University of California not be used in advertising or publicity pertaining to distribution of the
software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc, All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors

may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----
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Copyright » 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All rights
reserved. Use is subject to license terms below.

This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2004, Sparta, Inc All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS TAS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Name : NET-SNMP RMON

Description : NET-SNMP RMON utilities

License type : Alex Rozin, Optical Access

Copyright (C) 2001 Alex Rozin, Optical Access, All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and without
fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright
notice and this permission notice appear in supporting documentation.

ALEX ROZIN DISCLAIM ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL ALEX ROZIN BE
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Name : NTP - Network Time Protocol
Description : NTP Protocol

License type : NTP

Copyright (c) David L. Mills 1992-2009

Permission to use, copy, modify, and distribute this software and its documentation for any purpose with or
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both the
copyright notice and this permission notice appear in supporting documentation, and that the name University
of Delaware not be used in advertising or publicity pertaining to distribution of the software without specific,
written prior permission. The University of Delaware makes no representations about the suitability this
software for any purpose. It is provided "as is" without express or implied warranty.

Copyright (c) 1990, 1993
The Regents of the University of California. All rights reserved.
This code is derived from software contributed to Berkeley by Chris Torek.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the University of California, Berkeley and its
contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Copyright (c) 1987, 1989 Regents of the University of California. All rights reserved.
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This code is derived from software contributed to Berkeley by Arthur David Olson of the National Cancer
Institute.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software
must display the following acknowledgement:

This product includes software developed by the University of
California, Berkeley and its contributors.

4. Neither the name of the University nor the names of its contributors
may be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS TAS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Copyright (c) 1983, 1993, The Regents of the University of California. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the University of California, Berkeley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS TAS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

Amanda, The Advanced Maryland Automatic Network Disk Archiver Copyright (¢) 1991-1998 University of
Maryland at College Park All Rights Reserved.
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Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting documentation, and that the name of U.M. not
be used in advertising or publicity pertaining to distribution of the software without specific, written prior
permission. U.M. makes no representations about the suitability of this software for any purpose. It is provided
"as is" without express or implied warranty.

U.M. DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL U.M. BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN

CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Author: James da Silva, Systems Design and Analysis Group Computer Science Department
University of Maryland at College Park

Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

License to copy and use this software is granted provided that it is identified as the "RSA Data Security, Inc.
MD5 Message-Digest Algorithm™ in all material mentioning or referencing this software or this function.

License is also granted to make and use derivative works provided that such works are identified as "derived
from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing the
derived work.

RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or the
suitability of this software for any particular purpose. It is provided "as is" without express or implied warranty of
any kind.

These notices must be retained in any copies of any part of this documentation and/or software.

Name : OpenSSL
Description : Toolkit implementing SSL v2/v3 and TLS protocols
License type : OpenSSL

Copyright (c) 2001 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact
openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment:

"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"
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THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT TAS IS" AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

Name : avitree

Description : Self-balancing binary search tree
License type : MIT

Copyright (c) 2011 Bijal Thanawala

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the
following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH
THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Name :eCos RTOS
Description : Real-time OS for embedded applications
License type : Modified GPL

This file is part of eCos, the Embedded Configurable Operating System. Copyright (C) 1998, 1999, 2000, 2001,
2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009 Free Software Foundation, Inc.

eCos is free software; you can redistribute it and/or modify it under the terms of the GNU General Public
License as published by the Free Software Foundation; either version 2 or (at your option) any later version.

eCos is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public
License for more details.

You should have received a copy of the GNU General Public License along with eCos; if not, write to the Free
Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA.

As a special exception, if other files instantiate templates or use macros or inline functions from this file, or you
compile this file and link it with other works to produce a work based on this file, this file does not by itself cause
the resulting work to be covered by the GNU General Public License. However the source code for this file must
still be made available in accordance with section (3) of the GNU General Public License v2.
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This exception does not invalidate any other reasons why a work based on this file might be covered by the
GNU General Public License.
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